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1. 개요

1-1 모델 개요

Application 예제는 실무에서 일반적으로 적용되는 구조해석 및 설계 절차를 실례를

통하여설명하는 midas Gen의실무적용지침서입니다.

구조해석에 익숙하지 않거나 midas Gen을 처음 접하는 사용자는 이 Application

예제를 통해 midas Gen의 다양하고 강력한 기능들을 효과적으로 활용하여, 정확하고

효율적인 구조해석과 경제적이고 안전한 구조설계를 수행하는 방법을 습득할 수

있기바랍니다.

Application 예제를 통해 midas Gen의 실무적용법을 익히기 전에, Getting Started와

Analysis & Design Manual에서 구조해석과 설계의 기본이론을 습득하고, 따라하기

예제를통해 midas Gen의기본기능을익히는것이바람직합니다.

본 예제에서 midas Gen을 이용하여 철근콘크리트조 건물을 해석하고 설계하는

절차는다음과같습니다.

1.    작업기본환경설정

2.    부재재질과단면데이터의입력

3.    절점과요소의입력

4.    경계조건의입력

5.    하중의입력

6.    구조해석의수행

7.    해석결과의검토, 비정형평가및사용성평가

8.    철근콘크리트부재설계
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1. 개요

건물위치 서울시

구조형식 Dual Systems with Reinforced Concrete Frames and Shear Wall

건물용도 업무시설, 판매시설

건물규모 지상 12층

구조시스템
지진하중의 25% 이상을부담하는철큰콘크리트골조와전단벽
으로이루어진이중골조시스템

그림 1.1  Reinforced Concrete Building

1-2 구조 개요
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1. 개요

부재명 단면번호 단면치수

G1 211 400 X 700

G2 212 400 X 700

G3 213 600 X 800

G4 214 500 X 800

G3A 215 600 X 800

WG1 221 400 X 700

WG2 222 600 X 800

WG3 223 600 X 800

그림 1.2  2~3F 구조평면도 (단위 : mm)

1-3 구조 평면 및 단면
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1. 개요

부재명 단면번호 단면치수

G1 411 400 X 700

G2 412 400 X 700

G3 413 600 X 800

G4 414 500 X 800

WG1 421 400 X 700

WG2 422 600 X 800

WG3 423 600 X 800

그림1.3 (4F~Roof)
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1. 개요

층 단면번호 C2 단면번호 C3 단면번호 C4

10 ~ 12 206 600 x 600 306 600 x 700 406 600 x 700

8 ~ 9 205 600 x 800 305 600 x 800 405 600 x 800

6 ~ 7 204 600 x 800 304 600 x 800 404 600 x 800

4 ~ 5 203 800 x 800 303 800 x 800 403 800 x 800

2 ~ 3 202 900 x 1000 302 800 x 800 402 900 x 900

1 201 1000 x 1000 301 1000 x 1000 401 900 x 900

층 단면번호 C1 단면번호 C1A

10 ~ 12 106 600 x 600 156 500 x 600

8 ~ 9 105 800 x 800 155 500 x 600

6 ~ 7 104 800 x 1000 154 500 x 600

4 ~ 5 103 1000 x 1000 153 600 x 600

2 ~ 3 102 1000 x 1200 152 700 x 700

1 101 1000 x 1300 151 700 x 700

그림1.4 단면도
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1. 개요

1-4 적용기준

• 건축구조설계기준 (KBC 2009) / 건설교통부

• 콘크리트구조설계기준 (KCI-USD12, 토목/건축통합기준) / 한국콘크리트학회

1-5 사용재료

• 콘크리트 : 

• 철 근 :  KSD 3504  SD40 

1-6 특기사항

• 건물의 바닥 슬래브는 하중으로 고려하고 구조모델에서는 제외합니다. 슬래브의

강막효과(Rigid Diaphragm Effect)는 Story기능을 이용하여 기구학적 구속조건으로

고려합니다.

• 바닥판을 지지하는 작은보는 중력방향의 하중만을 전달하고, 구조물의 횡적거동

에는 영향을 미치지 않으므로 해석모델에서는 제외하고, 작은보의 자중과 중력

하중전달은바닥하중입력시고려합니다.

• 지하구조물은 횡력에 영향을 받지 않고, 지진시 지반과 함께 거동하는 것으로

가정하여해석모델에서는제외합니다.

• 부재설계시영향면적에따른적재하중의감소는본예제에는고려하지않습니다.

224 /=ckf N mm
2400 /=yf N mm
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1. 개요

판매시설 업무시설 지붕 발코니

층 2 ∼ 3F 4 ∼ 12F Roof 전층

고정하중 4.6 4.0 5.3 4.6

적재하중 4.0 2.5 2.0 4

설계기본풍속 30 m/ sec (서울지역)

노풍도 B

중요도계수 1.0

가스트영향계수 Gx: 1.9265  / Gy: 1.9208  (강체건축물)

1-7 적용하중

• 중력방향하중

• 풍하중

건축물에작용하는풍하중은 “건축구조설계기준(KBC 2009)/국토해양부”를

적용하며, midas Gen의풍하중자동연산기능을이용하여입력합니다.

지형에의한풍속할증은불필요한것으로가정합니다.

모델에적용되는하중은실의용도와마감의종류에따라상세히구분되어야하지만,

본예제에서는해석의편의를위해위의표와같이대표적인하중만을적용합니다.

적재하중은 등분포 적재하중이 작용할 때 구조부재에 더 큰 응력이 발생하는 것으로

가정하고, 집중적재하중은생략합니다.

(단위: kN/m2)

지형에의한풍속할증은불필요한것으로가정합니다.
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1. 개요

• 지진하중

지진하중은 “건축구조설계기준 (KBC 2009)/건설교통부”을 적용하며 ,

응답스펙트럼과 등가정적 해석법두가지 방법에 대해 모두 평가하겠습니다.

지진하중은 midas Gen의하중조건생성기능을이용하여입력합니다.

지역계수 A = 0.22 (지진구역 Ⅰ)

지반종류 Sd

내진등급 Ⅰ

중요도계수 IE = 1.2 (내진등급 Ⅰ, 도시계획구역)

내진설계범주 D

건물의높이 Hn = 50 m

건물의폭 Bx = 36m,  By = 29.1m

반응수정계수 R = 5.5

지진력의 25%이상을 부담할 수 있는 중간 모멘트골조가 전단벽과 조합되어 수직하

중및횡력을건축물수직저항부재의강성비에따라부담하는것으로가정합니다.

• 단위하중조합

단위하중조건을다음과같이부여합니다.

하중조건번호 하중조건이름 발코니

1 DL 자중 + 고정하중

2 LL 활하중

3 WX
풍하중

(전체좌표계 X 방향)

4 WY
풍하중

(전체좌표계 X 방향)



2. 구조모델링
KBC2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

midas Gen 2015
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2. 구조모델링

이 장에서는 예제모델의 기하학적 형상과 모델을 구성하는 요소들의 재질과

단면성질그리고경계조건및작용하중을입력합니다.

midas Gen에서는단위계, 사용자좌표계, Snap 상황또는 Activity 등을사용자가원하

는대로설정하여사용할수있습니다.

효율적인 구조해석작업을 수행하기 위해서는 사용자가 이러한 기능들을 이용하여

효과적인작업환경을구축하는것이가장중요합니다.

초기환경으로 2층 바닥의 요소 입력이 용이하도록 UCS와 선그리드 및 View Point를

설정합니다.

Toolbar의배치는 Steel Application을참조하여동일하게배치합니다.

2-1 단위계 설정

2-2 UCS 설정

2층 바닥의 입력편의를 위해 2층 바닥 위치 GCS X-Y평면을 UCS X-Y평면으로 설정

합니다.

사용자의초기환경설정

에따라 Icon Menu 의

Toggle on 상황은달라질

수있습니다. 불필요한

Icon은 Toggle off 하여혼

돈을방지하는것이바람

직합니다.



1. New 클릭

2. Save를클릭하고, 파일이름에 ‘RC’입력

3. 버튼클릭

4. Status Bar의단위변환창에서 ‘kN’과 ‘m’선택 Point Grid, Point Grid

Snap, Line Grid Snap 이 Toggle off되어있는지확인

1. Main Menu에서 Structure > UCS/Plan > UCS > X-Y Plane클릭

2. Origin 입력란에 ‘0, 0, 5’ 입력

3. Rotation Angle 입력란에 ‘0’ 확인

4. Change View Direction에 ‘’ 표시

5. 버튼클릭
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2. 구조모델링

2-3 선그리드 설정

일반적인 장방형 Frame의 입력이 용이하도록 선그리드를 배치합니다.

Main Menu의 Tools > Setti

ng > Preferences에서 초기

화면의 Grid, View Point, S

nap, 재질과 Output Format

의 초기값을 설정하거나

변경할수있습니다.

Fast Query기능은 Snap된

절점이나 요소의 속성을

보여주는 기능으로 그림

2.1 의 를 클릭하면

Toggle Off됩니다.

Fast Query기능으로 확인

할 수 있는 속성은 다음과

같습니다.

절점번호

좌표

요소번호

요소종류

재질/단면/두께번호

Beta Angle

연결된절점번호

요소길이/면적/체적

1.  Main Menu에서 Structure > UCS/Plan > Grids > Define Line Grid 클릭

2.                                    버튼클릭

3. Grid Name 입력란에 ‘2F’입력

4. X-Grid Lines란에서 버튼클릭

5. ‘Relative’확인

6. Lines입력란에 ‘4@9’입력후 버튼클릭

7. Y-Grid Lines란에서 버튼클릭

8. ‘Relative’확인

9. Lines 입력란에 ‘10.2, 7.2, 10.2, 1.5’입력후 버튼클릭

10. Add/Modify Grid Lines 대화상자의 버튼클릭

11.  Define Grids 대화상자의 버튼클릭

12.           Line Grid,         Line Grid Snap이 Toggle on 되어있는지확인

13. Zoom Fit 클릭





2.1  UCS와선그리드의결정

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2. 구조모델링

2-4 부재재질과 단면데이터의 입력

요소를생성하기전에, 사용재질및저층부보와거더의단면데이터를입력합니다.

재질번호는 동일한 재료를 사용하더라도 부재의 종류(Girder, Column, Brace 등)별로

가급적다양하게부여하는것이바람직합니다.

재질번호 이름 종류 재료강도

1 Girder Concrete

2 Column Concrete

3 Wall Concrete

4 Girder(2~4F) Concrete

5 Column(1~4F) Concrete

6 Wall(1~4F) Concrete

224ckf N / mm =

224ckf N / mm =

224ckf N / mm =

224ckf N / mm =

224ckf N / mm =

224ckf N / mm =

표 1.1  사용재질

1. Main Menu에서 Properties > Material > Material Properties클릭

2. 버튼클릭

3. Type of Design 선택란에서 ‘Concrete’선택

4. Standard에 ‘KS01(RC)’ , Code ‘KCI-2012’선택

5. DB선택란에서 ‘C24’선택

6. Name입력란에 ‘Girder’입력후, 버튼클릭

7. 동일한방법으로 ‘재질 2~6’을입력하고 버튼클릭
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2. 구조모델링

그림 2.2  단면성질대화상자

그림 2.3 재질데이터입력
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2. 구조모델링

가정 단면 데이터는 작용하는 중력방향 하중에 의한 부재별 응력과 처짐을 약산하여

이를만족하는가정단면을선정하여입력합니다.

따라서, 단면크기가같더라도작용하중이나경계조건등이다를경우에는다른단면

종류로입력합니다. (단면번호부여방법은 Steel Application 참조)

그림 1.2의가정단면데이터를참조하여그림 2.4과같이단면데이터를입력합니다.

그림 2.4 단면데이터입력

1. Properties대화상자에서 Section탭선택

2. 버튼클릭

3. Section ID 입력란에 ‘211’입력

4. Name 입력란에 ‘G1’입력

5. 단면의형상선택란에 ‘ Solid Rectangle’선택

6. DB/User선택란에서 ‘User’선택

7. H 입력란에 ‘0.7’, B 입력란에 ‘0.4’입력

8. 버튼클릭

9. Properties대화상자의 버튼클릭

버튼을 클릭하면 해당 단

면의 강성데이터를 확인

할수있습니다.


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2. 구조모델링

여기서는 MGT Command Shell기능을 이용하여 단면데이터를 입력하는 방법에 대해

알아봅니다.

MGT Command Shell은 midas Gen의 Text형식 모델 데이터 파일인 fn .MGT의 명령어

형식대로모델데이터를입력하는기능입니다.

그림 2.5  Exported MGT File (RC(mgt).mgt)

1. Windows 바탕화면에서 midas Gen 실행

2.    Quick Menu에서 New 클릭

3. Open을클릭하여예제첨부파일인 ‘RC(KBC2009).mgb’ 클릭

4.    File Menu에서 Export > midas Gen MGT File 선택

5.    경로를지정하고파일이름으로 ‘RC(mgt)’를입력

6.                           버튼클릭

7.    그림 2.5의 Text Editor에서 ‘*SECTION’의모든단면데이터를마우스로선택

8. 마우스의우측버튼을클릭하여 Copy 선택

9.    RC.mgb 파일로돌아와서 Main Menu의 Tools > Command Shell > MGT

Command Shell 클릭

10.  마우스의우측버튼을클릭하여 ‘Paste’ 선택

11.  그림 2.6 의 버튼클릭

12.  그림 2.6 의 Message 확인후 버튼클릭

13. Properties 대화상자에서 Section탭클릭

14. 추가된단면데이터확인

15.  RC.mgb파일을제외한모든창종료

“Ctrl + F”기능을이용하면

“*Section”의 데이터가 있

는위치를쉽게찾을수있

습니다.

 다른모델파일에서단면

정보를가져오는방법은

MGT Command Shell을이

용하는방법이외에

Section Properties 대화창

에서 Import기능을이용하

여간단하게 입력할수도

있습니다.


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2. 구조모델링

그림 2.6  MGT Command Shell을이용한단면데이터입력

그림 2.7 추가된단면데이터





1. Properties대화상자에서 “Thickness” 탭선택

2. 버튼클릭

3. Thickness ID 입력란에 ‘200’입력

4.    Thickness의 In-plane & Out-of-plane 입력란에 ‘0.2’ 입력

5.                          버튼클릭

6. 버튼클릭

Massage Window 창에

Warning 메시지가발생하

는이유는이미 page.18에

서설정하였던 “G1”단면

과중복되기때문에나타

나는것입니다.


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그림 2.8 2층바닥보요소의생성

2-5 2층 바닥요소 입력

2층바닥요소를선그리드를이용하여입력합니다.

입력순서는G1, G2, G3, G4, WG1, WG2,WG3 순서대로입력하며절점번호, 

요소번호는 [그림 2.8]을참고하여그림과일치되도록요소를입력합니다.

1.            Hidden,         Display Node Numbers,         Display Element Numbers 클릭

(Toggle on)

2.    Main Menu에서 Node/Element > Element > Create Elements 클릭

3.    Element Type 선택란에서 ‘General beam/Tapered beam’ 확인

4.    Material Name 선택란에서 ‘1: Girder’ 확인

5.    Section Name 선택란에서 ‘211:G1’ 선택평면상에서 G1의위치를확인하여

시작점과끝점을클릭하여요소를생성 (그림 1.2 참조)

6.   동일한방법으로 G2, G3, G4, WG1, WG2, WG3 순으로 2층바닥의보요소를

생성

7.            Line Grid,         Line Grid Snap 클릭 (Toggle off)

2. 구조모델링

Line Grid의 교점을 클릭

하여도 요소가 생성되지

않는 경우에는 Nodal

Connectivity 입력란을 마

우스로 한번 클릭하여 연

초록색으로 색이 반전되

면 다시 부재 위치를 클릭

해줍니다.



Steel Application의경우와

같이 Frame Wizard를사용

하여 2층 바닥을 생성할

수있습니다.

그러나 Frame Wizard를사

용할 경우네는 본 예제의

모델과는 절점번호, 요소

번호가 일치하지 않으므

로주의하여야합니다.



따라하기의 원활한 진행

을 위해서 절점 및 요소의

번호를 그림과 일치하도

록모델을생성합니다.



Element 요소 ‘2, 4, 6, 7, 10’

은 모델 상부의 캔틸레버

요소(Node 4, 8, 12, 16, 20)

까지한번에생성합니다.





22

midas Gen Tutorial KBC 2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

코어벽체 및 불연속 벽체 모델에 필요한 절점 생성을 위해 요소 분할 기능을

이용합니다.

그림 2.9  코어부보요소의입력




2. 구조모델링

1.    Section Name 선택란에서 ‘221: WG1’ 선택

2.    그림 2.9 의 Element Snap 조정란에 ‘3’ 입력

3.    요소 34의 1/3 지점과요소 35의 1/3 지점을클릭하여요소 37 생성

(그림 2.9 참조)

4.    Element Snap 분할개수입력란에 ‘2’ 입력

5.    요소 38의 1/2지점과요소 39의 1/2지점을클릭하여요소 40생성

(그림 2.9 참조)

6. Select Single을이용하여요소 ’32, 37’를선택

7. 기능목록표에서 Divide Elements 선택 Element Type 선택란에서 ‘Frame’ 확인

8.    Divide 선택란의 ‘Equal Distance’ 확인

9.    Number of Division x입력란에 ‘2’ 확인후 버튼클릭

10.       Select Single을이용하여 40번요소선택

11.  Element Type 선택란에서 ‘Frame’ 확인

12.  Divide 선택란의 ‘Parametric Unequal Distance’ 선택

13.  Ratio x 입력란에 ‘1/3’ 입력후 버튼클릭
Parametric Unequal Distan

ce는 요소좌표계를 기준

으로 요소길이의 상대부

등간격 비율을 입력하여

요소를 분할합니다. 따라

서 그림 2.10과 같이 요소

분할이 되지 않은 경우는

요소좌표계가 다르기 때

문이므로 Ratio x 입력란

에 ‘2/3’을입력합니다.



Element Snap은 입력된 수

의 등분위치에서 Snap이

되는 옵션으로서 부재를

분할과 동시에 작업이 가

능합니다.


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그림 2.10  불연속벽체 절점 생성

2. 구조모델링

1.             Select Single을이용하여 36번요소선택

2. Element Type 선택란에서 ‘Frame’ 확인

3.    Divide 선택란의 ‘Equal Distance’ 선택

4.    Number of Division x입력란에 ‘3’ 입력후 버튼클릭

5. Select Single을이용하여 36, 46번요소선택

6.    Number of Division x입력란에 ‘2’ 입력후 버튼클릭

7.            Display 클릭

8.    Property 탭의 Property Name에 ‘’ 표시하고,                               버튼클릭

9.            Display Node Numbers 클릭(Toggle off)

10.         Shrink를클릭하여(Toggle on) 요소의입력상태를확인(그림 2.11 참조)

11.  입력상태확인후 Property탭의 Property Name에 ‘’ 표시해제후

버튼클릭
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그림 2.11  2층바닥보요소의입력상황확인

2. 구조모델링
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2-6 1층 기둥요소 생성

2층 바닥요소입력시생성된절점을 선요소로 확장변환하는 Extrude Elements기능을

이용하여 1층기둥요소를생성시킵니다.

그림 2.12  Extrude기능을이용한기둥생성

2. 구조모델링

1.    Main Menu에서 Grids/Snap > UCS/GCS > GCS 클릭

2.            Display Node Numbers 클릭(Toggle on)

3.            Select All 클릭

4.            Unselect by Window를이용하여절점 ‘4, 8, 12, 16, 20, 26, 27, 28, 29, 30, 31,

32’과절점 ‘33, 34, 35, 36’선택

5.    Main Menu에서 Node/Element > Elements > Extrude Elements 선택

6.    Extrude Type 선택란에서 ‘Node → Line Element’ 확인 Reverse I-J 입력란에

‘’표시

7. Element Type 선택란에서 ‘Beam’ 확인

8.    Material 선택란에서 ‘2 : Column’ 선택

9.    Section 선택란에서 ‘101 : C1’ 선택

10.  Generation Type 선택란에서 ‘Translate’ 확인

11.  Translation 선택란에서 ‘Equal Distance’ 확인

12.  dx, dy, dz 입력란에 ‘0, 0, -5’ 입력

13.  Number of Times 입력란에서 ‘1’ 확인하고,                     버튼클릭

13.           Iso View 클릭

14.           Shrink 클릭(Toggle off)

Unselect 된절점들은코어

부와 캔틸레버 보, 벽체를

구성하는 절점으로 기둥

이 생성되지 않는 위치입

니다.



Reverse I-J 선택란

Extrude 수행시 Translate

방향과 반대로 요소의 생

성방향을결정합니다.

요소의 생성방향과 요소

좌표계는 부재력 확인시

혼돈을 방지하기 위해 가

급적일치시킵니다.


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2-7 생성된 기둥요소 단면변경

Extrude기능에의해생성된기둥요소의단면번호를 Work Tree의 Drag&Drop 기능을

이용하여 [그림 1.2] 구조평면도와같이변경합니다.



그림 2.13  Select Identity를이용한속성별선택

2. 구조모델링

1. Tree Menu의Works탭(그림 2.13의참조) 선택

2. Works탭의 Properties > Section에서 ‘101:C1’을선택한후오른쪽마우스클릭

3. Context Menu에서Active(그림 2.13의참조)를클릭하여

기둥요소(C1)만을활성화

4. Display Node Numbers 클릭 (Toggle off), Top View클릭

5. Display를클릭하여 Property탭의 Property Name에 ‘’표시

6. 버튼클릭

7. Select by Window를이용하여변경될단면선택(그림 1.2참조)

8. Works탭의 Properties > Section에서 ‘151:C1A’를선택한후,

모델윈도우로 Drag&Drop (그림 2.14의참조)

9. 동일한방법으로그림 2.14을참고하여 1층기둥요소의단면번호변경


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Selection

2. 구조모델링

그림 2.14  1층변경된기둥단면확인

Drag

Drop
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2-8 벽요소 생성

2층바닥에생성된절점을 1층바닥으로복제하여벽요소를생성합니다.

그림 2.15  벽요소를구성하는절점복제

2. 구조모델링

1. Activate All 클릭

2. Hidden 클릭(Toggle off), Display Node Numbers 클릭(Toggle on)

3. Iso View클릭

4. Display를클릭하여 Property탭의 Property Name에 ‘’선택해제(Check off)

후 버튼클릭

5.            Select by Window를이용하여절점 ‘26, 27, 28, 29, 30, 31, 32’선택

(그림 2.15 )

6. Main Menu에서 Node/Element > Nodes > Translate Nodes 클릭

7. Mode 선택란에서 ‘Copy’확인

8. Translation 선택란에서 ‘Equal Distance’확인후, dx, dy, dz 입력란에

‘0, 0, -5’입력

9. Number of Times 입력란에서 ‘1’확인후, 버튼클릭

10. Top View클릭

11. Selection Filter by Direction선택란[그림 2.15]에서 ‘none’확인

12. Select by Window를이용하여 [그림 2.16]과같이선택

13. Activate, Iso View클릭





벽요소 생성시에는 벽요

소가 생성될 위치에 반드

시절점이있어야합니다.



그림 2.15 의 절점선택

란 ‘26 to 32’ 입력 후 엔터

를 치면 복제대상 절점이

선택됩니다.




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그림 2.16  코어부 선택



복제한 절점을 이용하여 벽요소를 입력합니다.  

1.    기능목록표에서 Create Elements 클릭

2.    Element Type 선택란에서 ‘Wall’ 선택하고, Membrane 선택확인, Wall ID ‘1’

확인 Material Name 선택란에서 ‘3 : Wall’ 선택

3.    Thickness 선택란에서 ‘200 : 0.2’ 확인

4. Intersect의 Node에 ‘’ 표시확인

5.            Display를클릭하여 Element탭의 Wall ID에 ‘’표시후,     

버튼클릭

6.    절점 ‘44, 45, 11, 10’을마우스로클릭하여 Wall ID 1 생성

(그림 2.17 (a) 참조)

7.    절점 ‘44, 57, 26, 10’을마우스로클릭하여Wall ID 2 생성

8.    절점 ‘61, 62, 31, 30’를마우스로클릭하여Wall ID 3 생성

9.    절점 ‘45, 58, 27, 11’을마우스로클릭하여 Wall ID 4 생성

10. 절점 ‘63, 60, 29, 32’를마우스로클릭하여Wall ID 5 생성

11.  절점 ‘59, 47, 14, 28’을마우스로클릭하여Wall ID 6 생성

12. 절점 ‘60, 48, 15, 29’를마우스로클릭하여Wall ID 7 생성

13.  절점 ‘47, 48, 15, 14’를마우스로클릭하여Wall ID 8 생성

14.  코어부벽요소생성을확인 (그림 2.17 (a) 참조 )

15. Activate All클릭,          Hidden클릭(Toggle on) (그림 2.17(b) 참조)

2. 구조모델링

Element Typed의 Wall ID

선택란에 Auto Inc로 되어

있으면 Wall ID가 자동으

로 1씩증가하면서생성됩

니다.


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

(a)



그림 2.17  2층바닥요소, 1층기둥요소및벽요소생성

(b)

2. 구조모델링
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2-9 Beam End Release 조건 입력

모델에 포함된 작은보들은 양단부가 거더에 의해 단순지지되는 것으로 가정하여

Beam End Release 조건을부여합니다.

2. 구조모델링

그림 2.18  Beam End Release 조건의입력

1.    Icon Menu에서 Angle View를클릭

2.    Horizontal에 ‘25’,Vertical에 ‘70’ 입력한후에 버튼클릭

3.            Zoom Window 클릭하여코어부를확대 (그림 2.18 참조)

4.    화면좌측 Tree Menu에서 Boundary탭선택

5.    기능목록에서 Beam End Release 선택

6.    [그림 2.18 ]의요소선택란에 ‘37, 40’ 입력후엔터

7.    Beam End Release대화창의 General Types and Partial Fixity 선택란에서

버튼클릭

8. 버튼클릭

9.    요소선택란에 ‘44, 45’입력후엔터

10.  General Types and Partial Fixity 선택란에서 버튼클릭

11.                      버튼클릭

12. Zoom Fit 클릭

13.           Display를클릭하여 버튼클릭

14.                                버튼클릭


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2-10 하중조건 설정

구조물에작용하는중력방향및횡방향하중을입력하기전에하중조건(Load Case)을

설정합니다. 

하중조건을설정하기위해 Load Case Name 선택란우측의버튼 (또는 Main Menu에서

Load > Create Load Cases > Static Load Cases)을클릭하여 Static Load Cases대화상자를

호출한다음아래와같이하중조건을입력합니다.

그림 2.19  하중조건설정

2. 구조모델링

1. Tree Menu에서 Load탭선택

2. Load Case Name 선택란우측의 버튼클릭

3. [그림 2.19]와같이 Static Load Cases 대화상자의 Name 입력란에 ‘DL’입력

4. Type 선택란에서 ‘Dead Load’선택 Description 입력란에 ‘Dead Load’입력

5. 버튼클릭

6. Static Load Cases대화상자에나머지하중조건을 [그림2.19]와동일하게입력

7. 입력완료후, 버튼클릭

하중조건 설정에 대한 자

세한 내용은 ‘따라하기 1’

의 하중조건 설정 부분 참

조



지진하중은 응답스펙트럼

해석을 수행할 것이므로

정적지진하중은 입력하지

않습니다.


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2-11 Beam Load 입력

Building Generation 기능을 이용하여 상부층 모델을 생성 시킬 때 Beam Load의 복제

가 가능하기 때문에 Building Generation을 하기 전에 먼저 Beam Load를 이용하여 발

코니하중을입력합니다.

그림 2.20 Beam Load 입력

2. 구조모델링

1.            Display Element Numbers 클릭(Toggle on)

2.            Select Single을클릭하여 Element 요소‘23, 26, 28, 30’ 선택

3. 기능목록표에서 Element Beam Loads 선택

4. Load Case Name 선택란에서 ‘DL’ 확인

5. Load Type 선택란에서 Trapezoidal Loads 선택

6. Vaule란에 Relative 확인

7.    x1 : ‘0’, x2 : ‘1.5/9’, x3 : ‘1-1.5/9’, x4 : ‘1’입력

8.    W1 : ‘0’, W2 : ‘-6.9’, W3 : ‘-6.9’, W4 : ‘0’ 입력

9.                        클릭

10.          Select Previous 클릭

11.  Load Case Name 선택란에서 ‘LL’ 선택

12. W1 : ‘0’, W2 : ‘-6’, W3 : ‘-6’, W4 : ‘0’ 입력

13.                      클릭
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그림 2.21 Beam Load 입력

2. 구조모델링

1. Select Single을클릭하여 Element 요소 ‘24, 25, 27, 29, 31’ 지정

2. Load Case Name 선택란에서 ‘DL’ 선택

3.    x1 : ‘0’, x2 : ‘1’, x3 : ‘0’, x4 : ‘0’입력

4.    W1 : ‘0’, W2 : ‘-6.9’, W3 : ‘0’, W4 : ‘0’  입력

5. 클릭

6.            Select Previous 선택

7.    Load Case Name 선택란에서 ‘LL’ 선택

8.    W1 : ‘0’, W2 : ‘-6’ 입력

9.                     클릭
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그림 2.22 Beam Load 입력

1. Select Single을클릭하여 ‘28, 29, 30’지정

2. Load Case Name 선택란에서 ‘DL’선택

3. x1 : ‘0’, x2 : ‘1’입력

4. W1 : ‘0’, W2 : ‘-6.9’입력

5. 버튼클릭

6. Select Single을클릭하여 ’28, 29, 30’지정

7. Load Case Name 선택란에서 ‘LL’확인

8. W1 : ‘0’, W2 : ‘-6’입력

9. 버튼클릭

10. Display Element Numbers 클릭(Toggle off)

2. 구조모델링
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2-12 Building Generation

지금까지 생성시킨 2층 바닥요소와 1층 기둥요소, 벽요소를 Building Generation 기능

을이용하여상부층으로복제합니다.

Building Generation기능을 이용하면 요소의 복제 시 발생되는 층고의 변화와 요소

종류별 단면번호의 증가를 모두 고려하여 한꺼번에 복제함으로써, 건축구조물을

간단하게모델링할수있습니다.

2. 구조모델링

1.            Select All 클릭

2.    Main Menu에서 Structure > Building > Control Data >Building Generation 선택

3.    Number of Copies 입력란에 ‘2’입력

4.    Distance(Global Z)입력란에 ‘4.5’입력

5.    Operations에서 버튼클릭

6.    Number of Copies 입력란에 ‘9’입력

7.    Distance(Global Z)입력란에 ‘4’입력

8.    Operations에서 버튼클릭

9.                                                                           버튼클릭

10.  [그림 2.23]과같이단면번호의증분을입력

11.                                 버튼클릭

12.  Copy Element Attributes 우측의 버튼클릭

13.  Boundaries의 Beam End Release에 ‘’표시확인

14.  Static Loads의 Beam Load에 ‘’표시확인

15.                                 버튼클릭

16.         버튼클릭

17.           Iso View  클릭

18.           Display를클릭하여 Boundary탭의 Beam End release Symbol, Load 탭의

Beam Load에 ‘’ 표시

19. 버튼클릭

20.  복제된요소들의 Beam End Release, Beam Load 조건확인

21.           Display를클릭하여 버튼클릭

22.                                 버튼클릭



37

midas Gen Tutorial KBC 2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

그림 2.23 Building Generation Table

그림 2.24  Building Generation을이용한상부층모델의생성

2. 구조모델링

Building Generation Table

에서 첫번째 열의 숫자는

복제할 치수를 의미합니

다. 예를 들면, 두번째 복

제를 수행할 때 즉, 2층의

요소를 3층으로복제할때

기둥의 단면번호에 ‘1’의

증분을 부여한다는 의미

입니다.

반드시해야 할과정은아

니며, 나중에 모델데이터

관리에 유용하게 활용될

수있는기능입니다.


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2. 구조모델링

2-13 불연속벽체 생성

불연속벽체를생성합니다.

1.    Main Menu에서 Structure > UCS/Plan > Named Plane 선택

2.    Plane Name에 ‘B’ 입력

3.    Plane Type에서 ‘X-Z Plane’선택

4.    B열상의임의의점을지정하여Y Position에 ‘10.2’을자동입력

5.                     버튼클릭

6.             Active Identity 에서‘Named Plane’을선택하고 ‘B’ 클릭

7. 버튼클릭

8. Front View 클릭

9.             Display를클릭하여 Element탭의 Wall ID에 ‘’표시후,                                                  

버튼클릭

10.  Main Menu에서 Node/Element > Elements > Create Elements 클릭

11.  Element Type 선택란에서 ‘Wall’ 선택, Membrane 선택확인

12.  Wall ID ‘9’ 입력

13.  Material Name 선택란에서 ‘3 : Wall’ 선택

14. Thickness 선택란에서 ‘200 : 0.2’ 선택

15.  절점 2, 34, 97, 65 순서대로클릭하여 Wall ID 9 생성

16.  절점 65, 97, 133, 101 순서대로클릭하여Wall ID 10 생성

17.  절점 101, 133, 457, 425 클릭하여 Wall ID 11 생성

18.                            버튼클릭

19.           Display를클릭하여 Element탭의 Wall ID에 ‘’표시해제후,  

버튼클릭
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2. 구조모델링

그림 2.25 불연속체벽생성

1.            Select Single 클릭

2. [그림 2.26]과같이 2층벽하부보요소선택

3.    Tree Menu 에서 Works탭클릭

4.    Section에서 ‘215:G3A’을 Drag & Drop 

5. Activate All클릭

2-14 보 단면요소 변경

지정되어있지않은단면을지정해줍니다.

그림 2.26 보단면요소변경
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2. 구조모델링

1.             Select by Window 클릭

2.    [그림 2.27]과같이모델맨윗부분을지정

3.             Activate,           Top View 클릭

4.    Works 탭 Section에서 ‘411:G1’ 더블클릭

5.    Section에서 ‘511:RG1’ 선택후모델윈도우로 Drag & Drop

6.    동일한방법으로 412:G2, 413:G3, 414:G4를 512:RG2, 513:RG3, 514:RG4로변경

7.             Activate All클릭,         Iso View 클릭

2-15 지붕 단면요소 변경

그림 2.28 지붕단면요소변경

Drag

Drop

그림 2.27 지붕단면선택
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2. 구조모델링

1. 요소선택란(그림 2.29참조)에 Element Number ‘54’입력후엔터

2. Works 탭 Section에서 ‘111:TC1’을 Drag & Drop

3. 요소선택란(그림 2.29참조)에 ‘51’입력후엔터

4. Works 탭 Section에서 ‘311:TC3’을 Drag & Drop

2-16 기둥 단면요소 변경

Drag

Drop

그림 2.29 기둥단면변경



54
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그림 2.30  Auto Generation을이용한 Story Data 입력

2. 구조모델링

2-17 층 데이터 입력

모델의 기하 형상이 완전히 입력되지는 않았지만 층 관련 부가기능을 이용하여

모델링을 쉽게 할 수 있도록 층 데이터를 먼저 입력합니다. 

층 데이터는 하중기준에 의한 풍하중 및 지진하중의 자동연산 입력기능을 이용하

고자 할 때 반드시 입력되어야 합니다.

1.    Main Menu에서 Structure > Building > Control Data > Story 선택

2. 버튼클릭

3.                                 버튼클릭

4.                                 버튼클릭

midas Gen에서는

Story Data를 자동생성 할

때 입력되어있는 모든 절

점의 Z 좌표를 층의 위치

로인식합니다.

따라서, Story Level이 아

닌 위치에 절점이 생성된

경우에는해당층을

Unselected List로 이동시

켜 Story Data에서 제외되

도록합니다.



Wind와 Seismic탭에서는

풍하중과 지진하중을 자

동연산 하는데 적용될 풍

압면의 폭, 층의 중심, 우

발 편심거리 등이 층별로

정리되어 있으며, 사용자

수정도가능합니다.


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그림 2.31  부재재질변경

2. 구조모델링

2-18 부재 재질 변경. 

1.           Display Story Number 클릭

2.           Activate by Identifying을선택

3.    Story 클릭후, ‘1F~4F’ 선택

4.    ‘+Both’ 체크후,                          클릭

5. 클릭

6.    Tree Menu 에서Works에서 ‘1:Girder’ 더블클릭

7.    ‘4:Girder(2~4F)’를선택하여 Drag & Drop

8.    2:Column와 3:Wall을같은방법으로 5:Column(1~4F), 6:Wall(1~4F)로변경

9.           Display Story Number (Toggle off),     Activate All클릭

Drag

Drop
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2-19 경계조건 입력

모델의 기하형상 입력이 완료되었으므로, 하단부에 지지조건을 입력합니다.

그림 2.32  구조물의지지조건입력

2. 구조모델링

1.           Select by Plane 클릭

2.    Plane 대화상자의 ‘XY Plane’ 선택

3.    1층바닥의임의의절점을지정하여 Z Position에 ‘0’을자동입력

4.                                                      버튼클릭

5.    Main Menu에서 Boundary > Supports > Define Supports 선택

6.    Options 선택란에서 ‘Add’확인

7.    Support Type 선택란에서 ‘D-All’, ‘R-All’에 ‘’ 표시

8. 버튼클릭



3. 하중입력
KBC2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

midas Gen 2015
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3. 하중입력

3-1 자중 입력

모델에 포함된 부재의 자중을 중력방향으로 고려합니다.

1.    Load Menu에서 Self Weight 확인

2.    Load Case Name 선택란에 ‘DL’ 선택

3.    Self Weight Factor ‘Z’ 입력란에 ‘-1’ 입력

4.    Operation에서 버튼클릭

그림 3.1  자중의입력



47

midas Gen Tutorial KBC 2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

3. 하중입력

3-2 바닥하중 종류 입력

중력방향 하중을 바닥하중으로 입력하기 위해 기능목록표에서 Assign Floor Loads를

선택합니다. 바닥하중을 입력하기 위해서는 먼저 바닥하중 종류를 정의(Define Floor

Load Type)합니다.

1.    기능목록표에서Assign Floor Loads 선택

2.    Load Type 선택란우측의 버튼클릭

2.    Name 입력란에 ‘판매시설’ 입력

3.    Description 입력란에 ‘2  3F’ 입력

4.    Load Case 선택란에서 ‘DL’ 선택후, Floor Load 입력란에 ‘-4.6’ 입력하고,   

Sub Beam Weight에 ‘’ 표시확인

5.    Load Case 선택란에서 ‘LL’ 선택후, Floor Load 입력란에 ‘-4.0’ 입력

6.                                  버튼클릭

7.    동일방법으로 11page 중력방향하중표와 [그림 3.2]를참조하여나머지하중을

입력 후,                                버튼클릭

그림 3.2  바닥하중형태입력

Floor Load는 보요소에 의

해 형성된 삼각형 또는 사

각형의 폐구간에 적용할

수 있습니다. 폐구간 내의

절점은 동일한 평면에 위

치하여야 합니다. 하지만

그 평면이 X-Y평면과 평

행할필요는없습니다.

Floor Load 기능을 이용하

면 경사지붕이나 외벽면

의 풍하중 또는 적설하중

도 간단하고 정확하게 입

력할수있습니다.


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3. 하중입력

3-3 바닥하중 입력

구조물에 작용하는 중력방향 하중을 입력합니다. 본 예제에서는 외벽 마감재나

설비시설(기계실, Cooling Tower 등)의 하중은 해석편의를 위해 생략합니다. 

1.            Select by Plane 클릭

2.    Plane 대화상자에서 ‘XY Plane’ 선택

3.    2층바닥임의의절점을클릭하여 Z Position ‘5’ 확인후

버튼클릭

4.            Activate 클릭

5.            Node Number 클릭 (Toggle on)

6. Load Type 선택란에서 ‘판매시설’ 선택

7.    Distribution 선택란에서 ‘Two Way’ 확인

8.    No. of Sub Beams 입력란에 ‘1’ 입력

9.  Sub-Beam Angle(A2) 입력란에 ‘90’ 확인

10.  Unit Self Weight 입력란에 ‘6.72’ 입력

11.  Load Direction 선택란에서 ‘Global Z’ 확인

12.  Copy Floor Load에 ‘’ 표시

13.  Axis에 ‘Z’ 확인후, Distance 입력란에 ‘4.5’ 입력

14.  Nodes Defining Loading Area 입력란을 Mouse로클릭하여 Mouse Editor 활성화

15.  절점 ‘1, 17, 19, 15, 14, 2, 1’ 클릭

16.  절점 ‘2, 10, 11, 19, 25, 21, 2’ 클릭

17.  Distribution 선택란에서 ‘One Way’ 선택 Load Angle(A1) 입력란에 ‘0’ 확인

18.  No. of Sub Beams 입력란에 ‘0’ 입력

19.  절점 ’26, 28, 29, 27, 26’ 클릭

Floor Load 입력내용에 오

류가 있으면 재하영역 지

정 후에도 화면에 Floor

Load Label이표시되지않

습니다. Floor Load 입력시

범하기 쉬운 오류는 다음

과같습니다.

1. 요소의중복입력

2. 요소종류입력오류

(트러스요소불가)

3. 요소분할오류

(벽요소와조합시)

4. 재하구간이평면이아

닌경우가상보에의해

분할된구간이오각형

이상의다각형인경우



Unit Self Weight는 모델에

포함되지 않는 보요소의

자중을 고려하는데 주로

적용하며 해당 가상보와

연결되는 보요소 (또는 벽

요소)상에 직중하중 형태

로 자동고려됩니다, 집중

하중의 작용방향은 Floor

Load입력란에 입력된 바

닥판 하중의 작용방향에

따릅니다.



재하영역의 평면형상에

따라 A1을 ‘0’혹은 ’90’으

로 변경하면서 재하영역

을 지정하면 좀더 간단하

게 하중을 입력할 수 있습

니다.


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3. 하중입력

4 12F의업무시설하중을입력합니다.

1.            Activate All 클릭

2.            Select by Plane 클릭

3.    Plane 대화상자에서 ‘XY Plane’ 선택

4.    4층바닥임의절점클릭하여 Z Poisition입력란에 ‘14’확인후,  

버튼클릭

5.            Activate 클릭

6.    Load Type 선택란에서 ‘업무시설’ 선택

7.    Distribution 선택란에서 ‘Two Way’선택

8.    No. of Sub Beams 입력란에 ‘1’ 입력

9.    Sub-Beam Angle(A2) 입력란에 ‘90’ 확인

10.  Copy Floor Load에 ‘’ 표시확인

11.  Axis에 ‘z’ 확인후, Distances입력란에 ‘8@4.0’입력

12.  Nodes Defining Loading Area 입력란을마우스로클릭하여 Mouse Editor 활성화

13.  절점 ‘100, 116, 118, 114, 113, 101, 100’ 클릭

14.  절점 ‘101, 109, 110, 118, 124, 120, 101’ 클릭

15.  Distribution 선택란에서 ‘One Way’ 선택

16.  Load Angle(A1) 입력란에 ‘0’ 확인

17.  No. of Sub Beam 입력란에 ‘0’ 입력

18.  절점 ‘125, 127, 128, 126, 125’ 클릭

장변/단변의 비가 크기 때

문에 1방향으로 하중흐름

을 가정하고 1Way로 입력

합니다. 1방향으로 하중

을 입력하여 해석한 경우

에는 설계에서도 1방향으

로 배근을 해 주어야 합니

다.

 
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3. 하중입력

그림 3.3  2층바닥하중입력

그림 3.4  고층부바닥하중입력
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그림 3.5  Floor Load Name

지붕층하중을입력합니다.

3. 하중입력

1.            Activate by Identifying 클릭

2.    Story를지정하고 Roof 선택

3.                              버튼클릭

4.                              버튼클릭

5.    Load Type 선택란에서 ‘지붕’ 선택

6.    Distribution 선택란에서 ‘Two Way’선택

7.    No. of Sub Beams 입력란에 ‘1’ 입력

8.    Sub-Beam Angle(A2) 입력란에 ‘90’ 확인

9.    Copy Floor Load에 ‘’ 표시삭제 (Check off)

10.  절점 ‘424, 440, 442, 438, 437, 425, 424’ 클릭

11.  절점 ‘425, 433, 434, 442, 448, 444, 425’ 클릭

12.  Distribution 선택란에서 ‘One Way’ 선택

13.  Load Angle(A1) 입력란에 ‘0’ 확인

14.  No. of Sub Beams 입력란에 ‘0’ 입력

15.  절점 ‘449, 451, 452, 450, 449’ 클릭

16.          Active All 클릭

17.          Node Number,         Hidden 클릭(Toggle off )

18.          Display를클릭하여, Load탭의 Floor Load Name에 ‘’표시

19.                               버튼클릭후, 하중입력상태확인

20.  Display 클릭하여 버튼클릭

21.                               버튼클릭

Story Name은 수직부재들

기준으로 부여된다. 예를

들어 ‘3F’이면 3층의 기둥

과 4층바닥을의미합니다.



Display의 Roor Load

는 Load Case에 제한을 받

지않습니다.



하중입력 상태 확인을 위

해서는 Dynamic View,

Display, Active Identity등

의 기능을 이용하면 편리

합니다.


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그림 3.6  Story Data

3. 하중입력

3-4 풍하중 입력

풍하중은“건축구조기준(KBC2009)/국토해양부”에따라 midas Gen의풍하중자동연산

입력기능을이용하여입력합니다. 

풍하중을 입력하기 전에 자동산정된 풍압면의 폭과 하중의 작용점이 적절한지 판단

합니다.

1.    Main Menu에서 Structure > Building > Control Data > Story 클릭

2. Wind탭(그림 3.6 )에서각방향의풍압면적계산에적용될폭과

하중의작용점을확인 (그림 3.6 참조)

3.    Story Data 대화상자의 버튼클릭


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그림 3.7  Wind Load Profile (WX)





3. 하중입력

1.    Main Menu에서 Load > Lateral > Wind Loads 선택

2.    Wind Loads 대화상자의 버튼클릭

3.    Load Case Name 선택란에서 ‘WX’선택

4.    Wind Load Code 선택란에서 ‘KBC(2009)’ 확인

5.    Wind Load Parameters의 Exposure Category에서 ‘B’ 확인

6.    Basic Wind Speed 입력란에 ‘30’ 확인

7.    Importance Factor 입력란에 ‘1’ 확인

8.    Topographic Factor at Building Ground Level Kzt 입력란에 ‘1’ 확인

9.    Gust Factor 오른쪽 버튼클릭

10.                                                                                                                버튼클릭

11.                                버튼클릭

12.  Wind Load Direction Factor (Scale Factor)에서 X-Dir 입력란에 ‘1’확인, 

Y-Dir 입력란에 ‘0’입력

13.                       버튼클릭

14.                                               버튼클릭

15.  그림 3.7 좌측하단의 Scroll Bar를조정하여 GL의 Story Shear 1766.5 kN

(그림 3.7 )확인

16.                             버튼클릭

Add/Modify Wind Load

Code대화상자의

버튼을 클릭하면 구조물

에 가해지는 풍하중정보

를 도표와 그래프로 확인

할수있습니다.(그림 3.7)



본 예제에서는 지형에 따

른 풍속할증은 불필요한

것으로가정합니다.



Wind Load Direction Factor

에서 X-Dir과 Y-Dir에 모

두값을입력하면 2방향으

로 동시에 하중이 가해지

므로 주의해야 하겠습니

다. 이기능은하중방향과

직각방향으로 동시에 작

용시키고자 하는 경우에

사용됩니다.







54

midas Gen Tutorial KBC 2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

그림 3.8  Wind Load Profile (WY)

3. 하중입력

풍하중 또는 등가정적 지진하중 자동연산기능에서, 적용할 하중기준과 변수를 입력

하면 각 층별로 계산된 하중을 Table과 Graph의 형태로 확인할 수 있습니다. 또한,

버튼(그림 3.7 )을 클릭하여 자동계산된 내역을 Text File의 형태로 출력할 수도

있습니다.

1.    Load Case Name 선택란에서 ‘WY’선택

2.    Wind Load Direction Factor(Scale Factor)에서 X-Dir 입력란에 ‘0’입력, 

Y-Dir 입력란에 ‘1’입력

3.                        버튼클릭

4.                                                버튼클릭

5.    그림 3.8 좌측하단의 Scroll Bar를조정하여 GL의 Story Shear          

2282.2kN 확인(그림 3.8 참조)

6.                               버튼클릭

7.    Add/Modify Wind Load Specification 대화상자에서 버튼클릭

8.    Wind Loads 대화상자의 버튼클릭



모델에 포함되지 않은 옥

탑이나 바람막이 벽 등에

의해 추가되는 풍하중은

Additional Wind Loads에

서직접입력합니다.


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그림 3.9  풍하중입력

3. 하중입력
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그림 3.10  Story Shear Force Ratio 옵션체크

3. 하중입력

3-5 Building Control Data

건축구조기준(KBC 2009)에 따른 내진설계를 위해서 반드시 체크해야 하는 항목 중

전도모멘트 (Overturning Moment), 안정계수 (Stability Coefficient), 강성 비정형

평가(Stiffness Irregularity Check)는 Story Shear를 사용합니다. 그러므로 Building

Control Data의 Story Shear Force Ratio 옵션이체크되어있는지확인합니다.

1. Main Menu에서 Structure > Building > Control Data 클릭

2.    Story Shear Force Ratio에 ‘’ 표시확인 

3.                                 버튼클릭

midas Gen 2015에서 ‘Story

Shear Force Ratio’옵션은

기본값으로 체크되어 고

려하고있습니다.


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내진설계범주가 ‘D’이므로 구조물의 비정형성을 판정하여 해석법을 결정해야 합니

다. 본구조물을비정형으로가정하고응답스펙트럼해석에의한비정형평가를한후

에 최종 해석법을 결정합니다. 본 따라하기에서는 Chapter 1에서 응답스펙트럼 해석

에 의한 설계절차를 설명하고 Chapter 2에서 등가정적 해석을 수행한 경우의 설계절

차에대하여설명합니다.

3. 하중입력

3-6 내진설계범주 판정 및 1차 해석법 결정

지진지역과 지반종류가 결정되면 단주기 및 1초주기 설계스펙트럼 가속도(Sds,Sd1)

가 자동으로 계산됩니다. 그리고 내진등급을 선택하면 내진설계범주가 자동 판정

됩니다.

1.    Main Menu에서 Load > Lateral > Seismic Loads 선택

2.                               버튼클릭

3. Seismic Load Code 선택란에서 KBC(2009) 확인

4.    Seismic Load Parameters의 Design Spectral Response Acceleration에서 Seismic     

Zone선택란에 ‘1’ 확인

5. Zone Factor선태란에서 ‘0.22’확인

6.    Site Class선택란에서 ‘Sd’ 확인

7.    Seis. Use Group 선택란에서 ‘I’확인 Importance(Ie) 선택란에서 ‘1.2’ 확인

8.    Seis. Design Category 에서 ‘Sds(C), Sd1(D) ➔ D’ 확인후

9.                      버튼클릭

- 내진설계범주‘D’에대한해석법

: 내진설계범주’D’에 해당하는 구조물의 해석에는 <표 0306.4.6>에 지정된 해석방

법또는그보다정밀한해석방법을사용하여야한다. 이경우에구조물이 <표 0306.

4.4>의 H-1 혹은 H-4에해당하는평면비정형성이없거나 <표 0306.4.5>의 V-1, V-4

혹은 V-5에해당하는수직비정형성이없는경우정형으로볼수있다.

➢ KBC2009-0306.4.5.3

지진지역과 지반종류가

결정되면 단 주기 및 1초

주기 설계 스펙트럼 가속

도 (Sds, Sd1)가 자동으로

계산됩니다.

(그림 3.11참조)



Sds와 Sd1의 내진 설계범

주 중에서 불리한 값을 선

택합니다.


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그림 3.11 내진설계범주결정

3. 하중입력
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그림 3.12  질량데이터자동생성

3. 하중입력

3-7 응답스펙트럼 해석조건 입력

건축구조설계기준(KBC 2009)에 의한 설계용 응답스펙트럼을 설정합니다. 구조물에

작용하는 지진하중을 응답스펙트럼 해석을 통해 고려하고자 할 때에는 먼저 고유치

해석에 필요한 질량데이터와 고유치 해석조건 및 응답스펙트럼이 입력되어야

합니다.

본 예제에서는 구조물에 입력한 고정하중을 통해 질량데이터를 자동생성하고,

기준에의한응답스펙트럼데이터를자동계산하여구조해석에적용합니다.

먼저구조물의자중과고정하중을이용하여질량데이터를자동생성합니다.

1.    Main Menu에서 Structure > Type > Structure Type 선택

2.    Convert Self-weight into Masses에 ‘’표시후 ‘Convert to X, Y’ 선택

3.                                버튼클릭

4.    Main Menu에서 Load > Structure Loads/Masses > Load to Masses선택

5.    Mass Direction 에서 ‘X, Y’ 선택

6.    Load Case 선택란에서 ‘DL’선택

7.    Scale .Factor ‘1.0’ 확인후 ,                               버튼클릭
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그림 3.13 고유치해석조건설정

다음은 응답스펙트럼 해석 조건을 설정합니다.

1.    Main Menu에서 Load > Load Type > Dynamic Load > Response Spectrum Data >       

RS Load Cases 선택

2.                                                                            버튼클릭

3.    Type of Analysis에서 ‘Eigen Vectors’ 선택확인

4.    Number of Frequencies입력란에 ‘15’ 입력후,                             버튼클릭

각모드별해석결과를조합하는방법을지정하고, 하중기준에의한설계용응답스펙

트럼을생성합니다.

1.                                                                            클릭

2.    Response Spectrum Functions 대화상자의 버튼클릭

3.                                            버튼클릭

4. Design Spectrum 선택란에 ‘KBC(2009)’ 확인

5.    Design Spectral Response Acceleration의 Seismic Zone 선택란에서 ‘1’ 확인

6.    Zone Factor(S) 선택란에서 ‘0.22’확인 Site Class  선택란에서 ‘Sd’ 확인

7.    Importance Factor (Ie) 선택란에서 ‘1.2’확인

8.    Response Modification Coef. (R) 선택란에서 ‘5.5’선택

9.                                  버튼클릭

3. 하중입력

지진지역과 지반종류가

결정되면 단주기 및 1초

주기 설계 스펙트럼 가속

도(Sds, Sd1)가 자동으로

계산됩니다.

(그림 3.14의참조)


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그림 3.14 Design Spectrum 자동생성대화상자

생성된설계스펙트럼데이터를적용하여응답스펙트럼하중조건을생성합니다. 

본예제에서는전체좌표계 X축과 Y축방향을고려합니다.



1.    Add/Modify/Show Response Spectrum Functions 대화상자 버튼클릭

2.    Response Spectrum Functions 대화상자의 버튼클릭

3.    Modal Combination Control 우측 버튼클릭

4.    Modal Combination Type에서 ‘SRSS’ 선택확인후 버튼클릭

5.    Load Case Name 입력란에 ‘RX’ 입력

6.    Excitation Angle 입력란에 ‘0’ 확인

7.    Spectrum Functions의 Function Name(Damping Ratio)에서 KBC2009(0.05)에

‘’표시

8.    Accidental Eccentricity에 ‘’표시

9.    Operations 에서 버튼클릭

10. Load Case Name 입력란에 ‘RY’ 입력

11.  Excitation Angle 입력란에 ‘90’ 입력

12.  Operations 에서 버튼클릭

3. 하중입력

부재설계 및 비틀림 비정

형을 평가하기 위해서는

응답스펙트럼 해석시 우

발편심 모멘트를 고려해

야합니다.


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그림 3.15 응답스펙트럼하중조건입력

3. 하중입력



4. 구조해석수행
KBC2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

midas Gen 2015
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4. 구조해석수행

구조해석에 필요한 모델의 기하형상과 Property, 경계조건 그리고 하중까지 모두

입력되었으므로 구조해석을 수행합니다. 

그림 4.1 구조해석수행

1. Main Menu에서Analysis > Perform > Perform Analysis를클릭



5. 해석결과확인
KBC2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

midas Gen 2015
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5. 해석결과확인

비틀림 비정형 : 어떤 축에 직교하는 구조물의 한 단부에서우발 편심을 고려한 최

대층변위가그구조물양단부층변위평균값의 1.2배보다클때비틀림비정형인것

으로간주한다.

➢ KBC 2009 표-0306.4.4

5-1 비정형 평가 - 하중조합

내진설계범주 ‘D’인 경우에는 평면비정형 1, 4, 5 항목과 수직비정형 1~5 항목을

반드시 평가해야 합니다. 그러나 이 항목들이 모두 정형으로 판정되어도 평면비정

형 2, 3항목도 평가하여 보정계수(Cm : Scale Factor) 산정시 고려해야 합니다.

본 따라하기에서는 프로그램에서 평가 가능한 4가지 항목과 그 외 비정형항목을

평가합니다.

평면비정형 1 : 비틀림비정형평가

비틀림 비정형을 평가하기 위해서 우발편심모멘트를 고려한 응답스펙트럼 하중

조합을 생성합니다. 우발편심모멘트는 [그림 5.1(b)]와 같이 각 방향별로 두 가지를

고려해야하므로 4가지의하중조합을생성합니다.

1.    Main Menu에서 Results > Combination > Load Combination 선택

2.    Load Combinations에서 General Tab 선택

3.                                                     버튼클릭

4. Code Selection에서 “Concrete” 선택

5.    Design Code에서 ‘KCI-USD12’확인

6.                                 버튼클릭

7.    Load Combination List의 Name에서 ‘gLCB1, gLCB2, gLCB3, gLCB4’ 확인하중조합을생성합니다.

(그림 5.1 (b)의참조

 
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(b) 우발편심모멘트를고려한응답스펙트럼하중조합생성

그림 5.1 비틀림비정형을평가하기위한하중조합생성

5. 해석결과확인



비틀림비정형 평가시에

응답스펙트럼해석에 의한

우발편심모멘트를 고려하

기 위해 General Tap에서

그림 5.1(b)의 과 같이 4

가지 하중조합이 자동 생

성됩니다.



(a) 각방향별우발편심모멘트
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그림 5.2 각방향별비틀림비정형평가결과 Table

5. 해석결과확인

미리 생성해 두었던 우발편심모멘트를 고려한 응답스펙트럼 하중조합을 이용하여

비틀림비정형을평가합니다.

1.    Main Menu에서 Results > Tables > Results Tables > Story > Torsional Irregularity 

Check 선택

2.    Load Case/Combination 대화상자에서 gLCB1, gLCB2, gLCB3, gLCB4 ‘’ 표시

후 버튼클릭

비틀림 비정형 평가 결과 Maximum Story Drift값이 1.2×Story Drift보다 크기 때문에

본예제는비틀림비정형구조물에해당합니다.

Context Menu 의 ‘Select

Irregularity Ends’에서 User

Define으로사용자가 절점

을지정할수있습니다.


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강성비정형 : 어떤층의횡강성이인접한상부층횡강성의 70% 미만이거나상부 3

개층평균강성의 80% 미만인연층이존재하는경우강성분포의비정형이있는것

으로간주한다. 단, 임의의층의층간변위각에대한인접한상부층의층간변위각의

비가 130%이하이면예외로한다.(0306.4.4.2)

➢ KBC 2009 표-0306.4.5

그림 5.3 Story Drift와 Story Stiffness 계산방법지정

5. 해석결과확인

수직비정형 1 : 강성비정형평가

1.    Main Menu에서 Results > Tables > Results Tables > Story > Stiffness Irregularity 

Check(Soft Story) 선택

2.    Load Case/Load Combination 에서 RX(RS), RY(RS)에 ‘’ 표시후

버튼클릭

3.    Select Calculation Method의 Story Drift Method에서 ‘Drift at the Center of Mass’ 

확인

4. Story Stiffness Method 에서 ‘1/Story Drift Ratio’ 확인후 버튼클릭

5.    ‘Stiffness Irregularity(X) Tab’, ‘Stiffness Irregularity(Y) Tab’ 확인

층간변위(Story Drift)와층강성(Story Stiffness)을계산하는방법을지정합니다.

본 예제에서는 질량중심에서의 층간변위와 층간변위각(Story Drift Ratio)의 역수로

계산된층강성계산방법을선택합니다.
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(a)  Stiffness Irregularity(X) Tab

(b)  Stiffness Irregularity(Y) Tab

그림 5.4 강성비정형평가결과 Table

강성비정형평가결과 Story Stiffness Ratio가 1.0보다크기때문에본예제는강성비정

형이아닙니다. 만약 Story Stiffness Ratio가 1.0보다작더라도 Story Drift Angle Ratio가

1.3보다작으므로강성비정형에해당하지않습니다.

- Story Stiffness Ratio : Max{(Story Stiffness / 0.7Ku1), (Story Stiffness / 0.8Ku123)}

- Story Drift Angle Ratio : Story Drift / 상부층의 Story Drift

5. 해석결과확인
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중량비정형 : 어떤층의유효중량이인접층유효중량의 150%를초과할때중량분

포의비정형으로간주한다. 단, 임의의층의층간변위각에대한인접한상부층의층

간변위각의 비가 130% 이하인경우와 지붕층이 하부층보다가벼운 경우이면 예외

로한다. (0306.4.4.2)

5. 해석결과확인

➢ KBC 2009 표-0306.4.5

수직비정형 2 : 중량비정형평가

1.    Main Menu에서 Results > Tables > Results Tables > Story > Weight Irregularity  

Check 선택

2.    Load Case/Load Combination 에서 RX(RS), RY(RS)에 ‘’ 표시후

버튼클릭

3.    Select Calculation Method의 Story Drift Method 에서 ‘Drift at the Center of Mass’        

선택후 버튼클릭

4.    ‘Weight Irregularity(X) Tab’, ‘ Weight Irregularity(Y) Tab’ 확인

중량비정형 평가 결과 Story Weight Ratio가 1.0보다 작기 때문에 본 예제는 중량비정

형이 아닙니다. 만약 Story Weight Ratio가 1.0보다 크더라도 Story Drift Angle Ratio가

1.3보다작은경우는중량비정형에해당하지않습니다.

- Story Weight Ratio : Max{(Story Weight / 1.5M(U)), (Story Weight / 1.5M(L))}

- Story Drift Angle Ratio : Story Drift / 상부층의 Story Drift

그림 5.4 중량비정형평가결과 Table
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강도 비정형 : 임의 층의 횡강도가 직상층 횡강도의 80% 미만인 약층이 존재하는

경우 강도의 불연속에 의한 비정형이 존재하는 것으로 간주한다. 각층의 횡강도는

층전단력을부담하는내진요소들의저항방향강도의합을말한다.

5. 해석결과확인

➢ KBC 2009 표-0306.4.5

수직비정형 5 : 강도비정형평가

1.    Main Menu에서 Results > Tables > Results Tables > Story > Capacity Irregularity   

Check(Weak Story) 선택

2.    ‘Capacity Irregularity Tab’ 확인

강도비정형평가결과 Story Shear Strength Ratio가 0.8보다크므로본예제는강도비정

형이아닙니다.

-Story Shear Strength Ratio : Story Shear Strength / Upper Story Shear Strength

Angle은요소의강도를계산하는기준이되는방향이며일반적으로 Angle 1을하중이

작용하는방향으로지정하면입력된하중과층전단강도가일치하게되어서그때의

각층별강도를확인할수있습니다.

그림 5.4 강도비정형평가결과 Table
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그외비정형평가

midas Gen에서는앞서설명한프로그램으로판단가능한 4가지비정형평가를자동으

로 수행합니다. 그 외의 6가지 비정형평가 항목에 대해서는 프로그램에서 자동으로

판단하지않으므로설계자가직접평가해야하겠습니다.

평면비정형 2 - 요철형평면

- 내용 : 돌출한 부분의 치수가 해당하는 방향의 평면치수의 15%를 초과하면 요철형

평면을갖는것으로간주한다.

- 평가 : 본 예제는 직사각형 정형적인 평면이고 돌출한 부분이 없기 때문에 요철형

평면에해당하지않습니다 (Regular).

평면비정형 3 - 격막의불연속

- 내용 : 격막에서 잘려나간 부분이나 뚫린 부분이 전체 격막면적의 50%를 초과하거

나 인접한 층간 격막 강성의 변화가 50%를 초과하는 급격한 불연속이나

강성의변화가있는격막.

- 평가 : 본 예제는 격막에서 잘려나간 부분이나 뚫린 부분이 없고, 전층 격막 강성의

변화가없기때문에격막의불연속에해당하지않습니다 (Regular).

평면비정형 4 - 면외어긋남

- 내용 : 수직부재의면외어긋남등과같이횡력전달경로에있어서의불연속성.

- 평가 : 그림 5.7과 같이 전단벽의 면외 어긋남으로 횡하중 전달 경로가 불연속이

되었으므로비정형에해당됩니다 (Irregular).

평면비정형 5 - 비평행시스템

- 내용 : 횡력저항 수직요소가 전체 횡력저항 시스템에 직교하는 주축에 평행하지

않거나대칭이아닌경우.

- 평가 : 횡력저항 수직요소가 주축에 평행하지만, 평면이 대칭이 아니기 때문에

비평행시스템에해당됩니다 (Irregular).

수직비정형 3 - 기하학적비정형

- 내용 : 횡력저항시스템의수평치수가인접층치수의 130%를초과할경우기하학적

비정형이존재하는것으로간주한다.

- 평가 :본 예제는 직사각형 정형적인 평면이고 수직적인 변화가 없기 때문에 기하학

적비정형에해당하지않습니다 (Regular).

수직비정형 4 – 면내어긋남(횡력저항수직저항요소의비정형)

- 내용 : 횡력 저항요소의 면내 어긋남이 그 요소의 길이보다 크거나, 인접한 하부층

저항요소에 강성감소가 일어나는 경우 수직 저항요소의 면내 불연속에 의한

비정형있는것으로간주한다.

- 평가 : 그림 5.7와같이전단벽이최하부층까지연속되어있지않으므로비정형에해

당됩니다 (Irregular).

5. 해석결과확인
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그림 5.7 면내및면외어긋난부분

5. 해석결과확인

표 5.1 비정형평가정리

번호 유 형 판 정 비 고

H-1 비틀림비정형 Irregular 등가정적해석시비틀림증폭계수적용

H-2 요철형평면 Regular -

H-3 격막의불연속 Regular -

H-4 면외어긋남 Irregular 횡력저항불연속수직부재의 특별하중조합적용

P -5 비평행시스템 Irregular
비정형여부에관계없이, 내진설계범주 D이기때문에

Orthogonal Effect 고려

V-1 강성비정형 Regular -

V-2 중량비정형 Regular -

V-3 기하학적비정형 Regular -

V-4 면내어긋남 Irregular 횡력저항불연속수직부재의 특별하중조합적용

V-5 강도비정형 Regular -
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<표 0306.4.6> 내진설계범주 ‘D’에대한해석법

5. 해석결과확인

5-2 해석법 결정

본구조물은내진설계범주가 ‘D’이고 5층이상의비틀림비정형구조물이므로동적해

석법으로구조물을해석해야합니다(KBC 2009-표 0306.4.6참조).

구조물의형태 내진설계를위한해석방법

1. 3층이하의경량골조구조와각층에서유연한
격막을 갖는 2층 이하인 기타 구조로서 내진 등
급 II의구조물

등가정적해석법
동적해석법

2. 상기 1항이외의높이 70m 미만의정형구조물
등가정적해석법
동적해석법

3. <표 0306.4.5>에서유형 1,2 혹은 3의수직비정
형성을 가지거나 <표 0306.4.4>의 유형1의 비정
형성을 가지면서 높이가 5층 또는 20m를 초과하
는 구조물 또는 높이가 70m를 초과하는 정형 구
조물

동적해석법

4. 평면및수직비정형성을가지는기타구조물 동적해석법
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5. 해석결과확인

5-3 고유치 해석결과 검토

1.   Main Menu에서 Results > Tables > Results Tables > Vibration Mode Shape 선택

2.    Records Activation Dialog에서 클릭후테이블에서 X,Y 방향

주기확인

그림 5.9 Vibration Mode Shape
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5. 해석결과확인

그림 5.9 동적밑면전단력확인

5-4 응답스펙트럼 해석결과 검토

본 따라하기는 동적 해석이 요구되기 때문에 먼저 응답스펙트럼 해석결과를 검토하

고참고로 Chapter 2에서등가정적해석을한경우의검토절차도따라해보겠습니다.

보정계수(Cm : Modification Factor) 산정

응답스펙트럼해석을통해서구한구조물의밑면전단력을등가정적해석의밑면전단

력과비교하여, 그차이를보정하기위한보정계수를산정합니다.

등가정적해석법에서의밑면전단력은 midas Gen의등가정적지진하중자동연산기능

을이용하여산정합니다.

1.    Main Menu에서 Results > Tables > Results Tables > Story > Story Shear 

(Response Spectrum Analysis) 선택

2.    Spectrum Load Cases에서 RX(RS),RY(RS)에 ‘’표시후 버튼클릭

3.    RX 조건에서밑면전단력 ‘4774.4kN’ 과 RY조건에서 ‘3063.5 kN’ 확인
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5. 해석결과확인

1.    Main Menu의 Load > Lateral > Seismic Loads 선택

2.    Static Seismic Loads 대화상자의 버튼클릭

3.    Seismic Load Code 선택란에서 ‘KBC(2009)’ 확인

4.    Seismic Zone ‘1’, Zone Factor(S)‘0.22’, Site Class ‘Sd’ 선택

5.    Seis. Use Group란에 ‘I’, Importance(Ie)란에 ‘1.2’ 확인

6.    Approximate Period 의오른쪽 버튼클릭

7.    X-Direction Period, Y-Direction Period 선택란에 ‘3. T=0.049hn^(3/4)’선택후

버튼클릭

8.    Analytical Period 의 X-Dir.에 ‘1.1010’, Y-Dir.에 ‘1.2561’입력

9.    Response Modification Factor(R)에 X-Direction, Y-Direction 선택란에서 ‘5.5’ 

선택

10.                                                버튼클릭

11.  Scroll Bar를조정하여 GL의 Story Shear에서 ‘6326.8kN’ 확인

12.  Component 선택란에서 Y-Dir. 선택후 Scroll Bar를조정하여 GL의 Story Shear 

에서 ‘5545.54kN’ 확인

13.  모든창닫기

➢ X-Dir Scale-Up Factor  : 0.85 X (6326.8/4774.4) =1.13

➢ Y-Dir Scale-Up Factor  : 0.85 X (5545.5/3063.5) =1.54

양방향 조건이 동일하므

로 어느 방향으로 입력하

여도무방합니다.



비정형건물의

Modification Factor 산정시

고려하는계수 Cu를사용

0.9213x1.41253=1.301을

적용합니다.


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그림 5.10 밑면전단력 비교용 등가정적 지진하중

5. 해석결과확인
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건물은 0306.5에 따라 결정된 지진하중으로 인한 전도모멘트에 대하여 저항할 수

있도록설계하여야한다.

5. 해석결과확인

전도모멘트검토

midas Gen에서는 지진하중에 의한 각 층의 전도모멘트가자동으로 산출됩니다. KBC

2005 내진설계기준에서는전도모멘트에저항할수있도록저항모멘트를계산해야합

니다. 그러나 저항모멘트는 하중방향과 구조물의 형상에 따라서 변하므로 midas Gen

에서는수직부재의축력의합과중심을자동계산해줍니다.

➢ KBC 2009-0306.5.6.5

1.    Main Menu에서 Results > Tables > Results Tables > Story > Overturning Moment  

선택

2.    Load Case/Load Combination에서 RX(RS)에 ‘’표시후 버튼클릭

3.    마우스오른쪽클릭하여 Context Menu의 Set Overturning Moment Parameters

클릭

4.    Scale Factor for Response Spectrum 입력란에 ‘1.13’ 입력

5.    Define Reduction Factor에서 ‘Fixed(1.0)’선택후 버튼클릭

6.    Context Menu의Activate Records 클릭

7. Load Case/Load Combination에서 RY(RS)에만 ‘’표시후

버튼클릭

8.    Context Menu의 Set Overturning Moment Parameters클릭

9.    Scale Factor for Response Spectrum 입력란에 ‘1.54’넣고 버튼클릭

전도모멘트 감소계수는

정적해석에서 구한 결과

에서 고층 구조물에서 고

차모드의 영향을 고려하

는 계수로서 등가정적 지

진해석의 경우에는 층에

다라 감소계수를 다르게

적용합니다. 그러나 동적

해석에 대해서는 1.0으로

적용할수있습니다.


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(b) 보정계수(Cm)=1.55 적용한경우(RY Load Case)

그림 5.11 전도모멘트평가결과 Table

5. 해석결과확인

(a) 보정계수(Cm)=1.13 적용한경우(RX Load Case)
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수직부재 축력과 그 중심 좌표를 확인하여 전도모멘트에 저항하는 저항모멘트를

계산합니다.

e
Axial Force Sum

(a) Center of Axial Force Sum (b) Resistance Moment

그림 5.13 저항모멘트개념

1.    Main Menu에서 Results > Tables > Results Tables > Story > Story Axial Force Sum  

선택

2.    Load Case/Load Combination에서 DL(ST)에 ‘’ 표시후 버튼클릭

그림 5.12 Story Axial Force Sum Table

5. 해석결과확인
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표 5.2 저항모멘트비교

(단위 :  kN, m)

5. 해석결과확인

Story
Overturning Moment 

(RX)
Axial Force Sum X Distance

Resistance 

Moment (X)
Remark

12F 1106 9981 18.0152 179816.2159 OK

11F 2962 18727 18.0307 337664.5636 OK

10F 5309 27473 18.039 495586.2265 OK

9F 7980 36385 18.0294 655992.1005 OK

8F 10891 45296 18.0249 816457.8832 OK

7F 14009 54238 18.0182 977267.0221 OK

6F 17364 63179 18.0143 1138133.245 OK

5F 21011 72392 18.0049 1303414.802 OK

4F 24971 81605 18.004 1469216.802 OK

3F 29769 91393 18.0072 1645732.653 OK

2F 34858 101751 18.0093 1832469.47 OK

1F 40678 112510 17.9889 2023924.891 OK

Story
Overturning Moment 

(RY)
Axial Force Sum Y Distance

Resistance 

Moment (Y)
Remark

12F 1571 9981 14.1915 141969.6 OK

11F 4205 18727 14.2149 263051.4 OK

10F 7509 27473 14.2253 384252.6 OK

9F 11188 36385 14.2281 507545.7 OK

8F 15069 45296 14.2298 630881.1 OK

7F 19105 54238 14.2306 754554.9 OK

6F 23377 63179 14.2314 878140.7 OK

5F 28034 72392 14.2301 1005158.6 OK

4F 33187 81605 14.2293 1132275.7 OK

3F 39582 91393 14.2246 1268108.7 OK

2F 46496 101751 14.2201 1412285.4 OK

1F 54480 112510 14.2187 1561956.1 OK
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그림 5.15에서 P-delta 해석적용 여부를 확인한 결과가 ‘OK’이기 때문에 P- delta 해석

을 수행할 필요는없습니다(그림 5.15 참조). 만약 Remark에서 ‘P-delta Req.’가 출력되

면 P- delta 해석을수행해야하고, ‘Redesign’이출력되면건물은잠재적으로불안정하

므로재설계해야합니다.

안정계수(θ)가 0.1보다크고, θmax 이하일경우에는층간변위와부재력은 P-Δ효과

를고려하여산정하며, 특히 θ가 θmax보다클경우, 건물은잠재적으로불안정하므

로재설계해야한다.

P-delta 해석적용여부검토

안정계수를확인하여 P-delta해석적용여부를검토합니다. (KBC2009-0306.5.7.2)

➢ KBC 2009-0306.5.7.2

1.    Main Menu에서 Results > Tables > Results Tables > Story > Stability Coefficient 

선택

2.    Load Case/Load Combination에서 RX(RS)에 ‘’표시후 버튼클릭

3.    Deflection Amplification Factor(Cd)입력란에 ‘4.5’입력

4. Importance Factor(Ie)입력란에 ‘1.2’

5.    Scale Factor에 ‘1.13’ 입력

6.    Vertical Load Combination 선택란에 ‘DL’ 선택

7.                         버튼클릭

8. Vertical Load Combination 선택란에 ‘LL’ 선택

9.                         버튼클릭

10. Story Drift Method에서 ‘Drift on the Center of Mass’ 선택

11.                          버튼클릭

12.  Remark열에서 ‘OK’ 확인

13.  ‘RY(RS) Load Case’도같은방법으로 Stability Coefficient(Y) Tab에서확인

5. 해석결과확인

Stability Coefficient =

(Vertical Load*Modified

Drift) / (Story Shear Force*

Scale Factor*Height*Cd)

Modified Drift =

(Cd*Drift*Scale Factor)/(le)

Stability Coefficient계산시

Cd값과 Scale Factor값은

분모, 분자에서 감쇄되기

때문에 이 값들의 변경과

관계가없습니다.

단, Modified Drift값에는

영향을미칩니다.


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그림 5.14 안정계수의 Parameters 정의

그림 5.15 안정계수평가결과 Table

(b) Stability Coeffcient(Y) Tab

(a) Stability Coeffcient(X) Tab

5. 해석결과확인
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5. 해석결과확인

사용성평가

사용하중조건에서 지진하중 작용시에 층간 변위를 검토합니다. 이 구조물은 비틀림

비정형구조물이므로 모서리 층간변위 중 최대값과 허용 층간 변위와 비교하여 안정

성을평가합니다. 만약, 비틀림비정형이아닌경우에는질량중심에서의층간변위로

구조물의안정성을검토합니다.

1.    Main Menu에서 Results > Tables > Results Tables > Story > Story Drift 선택

2.    Load Case/Combination에서 RX(RS), RY(RS)에 ‘’ 표시후

버튼클릭

3.    Deflection Amplification Factor(Cd)에 ‘4.5’입력

4.    Importance Factor(Ie)에 ‘1.2’입력

5.    Scale Factor에 ‘1’ 입력

6.    Allowable Ratio에서 ‘0.015’ 입력

7.    Vertical Load Combination 선택란에 ‘DL’선택후 버튼클릭

8.    Vertical Load Combination 선택란에 ‘LL’선택후 버튼클릭

9.                            버튼클릭

10.  Maximum Drift of All Vertical Elements > Remark열에서 ‘OK’ 확인

11.  Drift on the Center of Mass > Remark 열에서 ‘OK’확인

12.  같은방법으로 RY(RS)하중조합을 Drift(Y)Tab에서확인

KBC 2009에서는 내진등

급에 따라 허용층간변위

가결정됩니다.

- 특 : 0.01 hx

- I : 0.015 hx

- II : 0.02 hx


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5. 해석결과확인

5-5 하중조합

1.    Main Menu에서 Results > Combination > Load Combination 클릭

2.    Concrete Design Tab 선택

3.                                                     버튼클릭

4.    Design Code에서 ‘KCI-USD12’ 확인

5.    Scale Up Factor에 RX 선택하고 ‘1.13’ 입력

6.                                버튼클릭

7.    RY 선택하고 ‘1.54’ 입력,                          버튼클릭

8.    Consider Orthogonal Effect에 ‘’ 표시

9.                                                                                          버튼클릭

10.  Load Case 1 에 ‘RX(RS)’, Load Case 2 에 ‘RY(RS)’선택

11.                         버튼클릭

12.                                버튼클릭

13.  ‘100 : 30 Rule’ 확인

14.  For Special Seismic Load 에 ‘’ 표시

15.  For Vertical Seismic Forces 에 ‘’ 표시

16.                                                                                        버튼클릭

17.  Vertical Load Factor에 ‘0.2’확인

18.  Sds 에 ‘0.49867’입력

19.  Load Case에 ‘RX(RS)’선택

20.  Over-Strength Factor에 ‘2.5’ 입력,  후 버튼클릭

21.  Load Case에 ‘RY(RS)’선택후, 버튼클릭

22.  Vertical Load Factor에 ‘0.2’확인후,      버튼클릭

23.                            클릭후,                                        버튼클릭
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그림 5.16

5. 해석결과확인
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5-6 반력및부재력확인

구조해석결과의타당성및사용성검토과정은 Steel Application을참조하기바랍니다.

본장에서는구조해석의결과로구해진반력및부재력을 Text Output형식으로출력, 

확인합니다.

5. 해석결과확인

1.    Main Menu에서 Results > Text > Text Output 선택

2.    Text Printout Wizard의 버튼클릭

3.    Output Load Set Name 입력란에 ‘Factored Load Set’ 입력

4.            버튼클릭

5.                                              버튼클릭

6.    Output Load Set Name입력란에 ‘Service Load Set’ 입력

7.                     클릭하여선택된하중조합조건의 ‘’ 표시해제

8.    76번항목 (SERV:D+L)과횡방향단위하중조건(WX, WY)에 ‘’ 표시하여

선택한후 버튼클릭

9.                              버튼클릭

10.  Element Output Selection 대화상자의 Output Load Set for Element Output 선택란

에 ‘Factored Load Set’ 확인

11.  Beam 선택란에 ‘’ 표시후 버튼클릭 (그림 5.18 참조)

12.  Element Selection Detail 대화상자의 Material 탭선택

13.  ‘2:Column’을선택한후 버튼을클릭하여 Unselected로이동

14.  Select Outputs 선택란에서 ‘Frc  Min/Max by property’만 Check on

15.  Output Detail 선택란에서 ‘5pt’ 선택 (그림 5.18 참조)

16.                            버튼클릭

17. 버튼클릭
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



그림 5.18 Element Selection Detail

그림 5.17  Text Printout Wizard

5. 해석결과확인
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그림 5.19 Output 별 Load Set 선택

5. 해석결과확인

1.    Displ & React. Output Selection 대화상자의 Output Load Set for Displacement 

Output 선택란에 ‘Service Load Set’ 선택

2.    Output Load Set for React. Output 선택란에 ‘Service Load Set’ 선택

(그림 5.19 참조)

3.    Displacement, Reaction 선택란에 ‘’ 표시후, Displacement의 버튼클릭

4.    ID 탭에 Selected에위치한모든절점번호확인

5. 그림 5.20 (a) 의 Story 탭을클릭하여 버튼클릭

6.    Unselected에서 ‘13 : Roof’ 선택한후 버튼클릭

7.    그림 5.20 (a) 의 Use 선택란에 ‘’ 표시

8.   Node Selection Detail 대화상자의 Reaction 탭선택

8.    Select Output에서 Local (if defined) 에 ‘’ 표시해제

9.                              버튼클릭

10.                            버튼클릭

11. Result Output List 대화상자의 버튼클릭

절점을 선택하는 구분자

로사용되는 ID, Story,

Named Plane, Group들은

각각의 선택된 범위의 공

통분모를 Text File형식으

로출력합니다.



최상층의 절점을 선택하

여 최대 변위를 확인합니

다.



반력 데이터는 별도로 대

상 절점을 지정하지 않더

라도 Support 조건이 부여

되어 있는 지점에 대해서

만반력이출력됩니다.


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(a)  Node Selection Detail-Displacement

(b)  Node Selection Detail-Reaction

그림 5.20

5. 해석결과확인

 

1.    MIDAS/Text Editor의 Edit > Find 선택

2.    Find 대화상자의 Find What 입력란에 ‘Reaction’ 입력

3.                              버튼클릭을반복(키보드 ^F클릭)하여 “REACTON FORCES & 

MOMENTS  DEFAULT PRINTOUT” 찾기

4.    사용성평가용 Load Set에의한반력확인 (그림 5.21 참조)

5.    키보드를사용하여 ‘Ctrl+F’ 누른후 Find 대화상자의 Find What 입력란에

‘MIN/MAX’ 입력후 버튼클릭

6.    부재력의하중조합별최대/최소값출력확인(그림 5.22 참조)

7.    Find 대화상자의 Find What 입력란에 ‘Displacement’ 입력후

버튼클릭

8.    Load Set에대한지붕층에변위값확인

9.            클릭하여 MIDAS/Text Editor 종료
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그림 5.21 지지점들의반력확인 (Service Load Set)

5. 해석결과확인
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그림 5.22 부재력의하중조합별최대/최소값

5. 해석결과확인
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5. 해석결과확인

그림 5.23 지붕층변위값확인 (Service Load Set)
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그림 5.24  코어부의절점번호선택

5. 해석결과확인

1.    Main Menu의 Results > Text > Text Output 선택

2.    Text Printout Wizard의 버튼클릭

3.    Load Case / Comb Selection대화상자의 Output Load Set Name 입력란에

‘부재력 Load Set’ 입력

4.             ,                          버튼클릭

5.    Element Output Selection 대화상자의Wall 선택후,         버튼클릭

6.    ID 탭에서 Selected에위치한모든요소번호확인

7.    Element Selection Detail 대화상자의Wall ID 탭클릭

8.                 버튼을클릭하여모든 Wall ID를 Unselected로이동

9.    Wall ID 에 ‘1’을선택하고,              버튼을클릭하여 Selected로이동

10.           ,                        버튼클릭

11.  Displ. & React. Output Selection 대화상자의 Reaction 선택란에 ‘’ 표시

12. Reaction 선택란우측의 버튼클릭

13. Node Selection Detail대화상자의 Reaction 탭에서 ID탭확인후

버튼클릭

14.  Unselected 입력란에 ‘44, 45, 47, 48, 57 to 63’ 입력후엔터 (그림 5.24 참조) 

15. 선택된절점번호를 버튼클릭하여 Selected로이동

16.                            버튼클릭

17.                            버튼클릭

18.                            버튼클릭

19.  코어부의반력확인

20.  벽부재의부재력확인

입력된 절점 번호는 Base

의 코어부를 구성하는 절

점번호입니다.


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그림 5.25  코어부의반력확인

5. 해석결과확인
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그림 5.26  벽부재의부재력확인(Wall ID 1)

5. 해석결과확인



6. 철근콘크리트부재설계
KBC2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

midas Gen 2015
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6. 철근콘크리트부재설계

이 장에서는 해석결과를 이용하여 철근콘크리트 보, 기둥, 벽체, 기초의 단면설계 및

강도검증과정을알아봅니다.

midas Gen에서는 다음과 같은 설계기준을 적용하여 철근콘크리트부재 자동설계를

수행할수있습니다.

한국콘크리트학회콘크리트구조설계기준(KCI-USD12, 토목/건축통합기준)

한국콘크리트학회콘크리트구조설계기준(KCI-USD99, 03, 07토목/건축통합기준)

대한건축학회극한강도설계법에의한철근콘크리트구조계산기준(AIK-USD94)

미국콘크리트학회철근콘크리트구조계산규준(ACI318-89, 95, 99)

대한토목학회콘크리트표준시방서(KSCE-USD96)

철근콘크리트 부재에 대한 단면 설계 및 강도검증은 사용자가 지정한 범위 또는

해석모델에포함되어있는전체철근콘크리트부재에대하여수행합니다.

이때, 단면설계 또는 강도검증은 각 철근콘크리트 부재의 단면이 부재 전길이에

대하여일정한단면형상을가지는철근콘크리트부재에대해서만수행합니다.

부재의 양단부 또는 부재의 임의의 위치에서 단면의 모양이나 크기가 변하는 변단면

부재는단면설계또는강도검증을할수없습니다.

철근콘크리트 부재는 다음과 같은 방법으로 단면설계 또는 강도검증을 선택적으로

수행합니다.

➢ 자동설계(Concrete Code Design)

단면설계는 해석모델에 입력된 부재 단면치수 또는 사용자가 수정한 부재단면치수

와 철근콘크리트 부재 설계용 하중조합조건에 의하여 산출된 계수하중을 기준으로

최적의 소요 철근량을 산출하는 과정입니다. 즉, 부재의 단면치수만 결정되어 있고

철근배근에 대한 데이터가 없는 경우 수행합니다.

➢ 강도검증(Concrete Code Check)

강도검증 부재의 단면치수와 철근배근 데이터가 함께 입력된 경우에는 완전한

철근콘크리트 단면으로 간주하고 , 이 단면에 대한 설계강도를 산출한 다음

해당부재의 소요강도와 비교 검증하는 과정입니다.
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6-1 설계변수

midas Gen의 철근콘크리트 부재의 설계기능은 Design 메뉴에서 제공되며 본 예제에

서 사용되는 Design Parameter로는 General Design Parameter와 Concrete Design

Parameter가있습니다.

General Design Parameter는 구조재와 부재의 종류와 관계없이 설계과정에서 공통적

으로 사용되는 설계변수 등을 입력하고, Concrete Design Parameter는 철근콘크리트

부재의설계과정에서사용되는설계기준이나구조재료의변경그리고부재단면데이

터의입력또는수정을합니다. 자동설계에적용할설계변수를입력합니다.

midas Gen에서는 Member Designation for Seismic Design 기능이 추가되어 건축구조

기준(KBC 2009)에 의한 특별지진하중 조합과 수직 지진력을 적용할 수 있습니다.

하중조합(Combinations)에서설정한 Factor를적용할 Member를지정합니다.

필로티 등과 같이 전체 구조물의 불안정성이나 붕괴를 일으키거나 지진하중

의흐름을급격히변화시키는주요부재의설계시에는지진하중을포함한지

진하중조합에지진하중(E) 대신특별지진하중(Em)을사용하여야한다.

평면비정형유형 H-4 또는수직비정형유형 V-4에해당하는구조물의불연속벽

, 기둥 및 기타 부재는 0306.2의 특별 조합하중에 저항할 수 있도록 설계하여야

한다.

내진설계범주 ‘D’로 분류된 구조물의 수평내민보와 프리스트레스를 받는 수평

요소는 해당 하중조합에 추가하여 고정하중의 20% 이상에 해당하는 상향하중

에저항할수있도록설계한다.

6. 철근콘크리트부재설계

➢ KBC 2009-0306.8.5

➢ KBC 2009-0306.2.3

➢ KBC 2009-0306.8.3
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6. 철근콘크리트부재설계

철근콘크리트부재의 General Design Parameter와 Concrete Design Parameter를지정합

니다.

1.    Main Menu에서 Design > General > General Design Parameter > 

Definition of Frame 선택

2.    X-Direction of Frame에 ‘Braced | Non-Sway’ 선택

3.    Y-Direction of Frame에 ‘Braced | Non-Sway’ 선택

4.                                  버튼클릭

5.             Front Veiw 클릭

6.             Select Window를이용하여 1F, 2F 지정

7.             Activate,         Iso Veiw클릭

8.    Design > General Design Parameters > Seismic Load Combination type 선택

9.    Assign Member 선택란에서 ‘for Special Seismic Loads’ 선택

10.           Select Single 클릭

11. Element No. ‘36, 46to49, 51, 54’선택

12.                      버튼클릭

13.           Activate All 클릭

14.           Top View 클릭

15.           Select by Polygon을이용하여수평내민보선택

16.           Iso Veiw 클릭

17.   Assign Member 선택란에서 ‘for Vertical Seismic Forces’ 선택

18. 버튼클릭

설계변수를 입력하지 않

으면 midas Gen에서 설정

된초기값이적용됩니다.

각 설계변수의 초기값은

On-line Manual참조


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그림 6.1 횡구속여부설정

그림 6.2 1F, 2F 활성화

6. 철근콘크리트부재설계
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그림 6.3 특별지진하중적용부재선택(전이보, 기둥)

그림 6.4 특별지진하중적용부재선택(수평내민보)

6. 철근콘크리트부재설계
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그림 6.5 Design Criteria of Rebars

6. 철근콘크리트부재설계

1.    Main Menu에서 Design > Design > RC Design > Design Code 선택

2.    Design Code 선택란에서 ‘KCI-USD12’ 확인

3.    Apply Special Provisions for Seismic Design에 ‘’ 표시

4.                                  버튼클릭

5.    Main Menu에서 Design > Design > RC Design > Strength Reduction Factors 선택

6. Strength Reduction Factors에서 For Tensile Control(phi_t) 입력란에 ‘0.85’,   

Member with Spiral Reinforcement(phi_c1) 입력란에 ‘0.7’, 

Other Reinforced Member(phi_c2) 입력란에 ‘0.65’, 

For Shear and Torsion(phi_v) 입력란에 ‘0.75’ 

확인 버튼클릭

8.    Main Menu에서 Design > Design > RC Design > Design Criteria of Rebars 선택

9.    Design Criteria of Rebars 대화상자에서 For Beam Design의 Main Rebar에 ‘D22’

확인

10.  Stirrups 선택란에서 ‘D10’ 확인

11.  Side Bar 선택란에서 ‘D13’ 확인

12. 버튼클릭

Applied Special Provision

for Seismic Design은 내진

설계 특별 규정의 적용여

부를 체크하는데 사용됩

니다.



Main Rebar를추가할경우

버튼을 클

릭하여 Rebar Data를 추가

할수있습니다.


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6. 철근콘크리트부재설계

6-2 보부재 설계

midas Gen에내장되어있는한국콘크리트학회콘크리트구조설계기준 (KCI-USD12)

을적용하여보부재의단면설계와강도검증을수행합니다.

입력된설계변수를기준으로 Main Menu에서 Design > Design > RC Design > Concrete

Code Design > Beam Design을 선택하여 보부재의 단면설계를 수행합니다. Beam

Design Result Dialog에서는 Member, 또는 Property 별로 단면설계 결과가 화면에

출력됩니다.

1.    Main Menu에서 Design > Design > RC Design > Concrete Code Design > 

Beam Design 선택

2.    Beam Design Result Dialog 대화상자의 버튼클릭(그림 6.6 참조)

3.    Result View Option의 NG 클릭

4.    Property ID 211에 ‘’ 표시하여선택

5.                                    버튼클릭

6.    Property ID 211 요약계산서에서 i, j단휨강도비 NG 확인. (그림 6.7 )

7.    Property ID 211 요약계산서의 버튼클릭

8.    Connect Model View에 ‘’ 표시

9.                                    버튼클릭

10.  Main Menu에서 Design > Design > RC Design > Design Criteria for Rebars by  

Member 선택

11.  Main Rebar에 ‘D25’ 선택

12.  Stirrups에 ‘D13’ 선택

13.  Arrangement에 ‘3’ 선택

14.                       버튼클릭

15.  Beam Design Result Dialog 대화상자의 버튼클릭

16.                                         버튼클릭

17.  NG난 Property확인후 클릭

18. Design Menu에서 Section For Design 선택

19.  222:WG2선택후 버튼클릭

20.  H:0.8, B:0.8 로변경후 버튼클릭

21.  같은방법으로 223: WG3은 H:0.9, B:0.8, 422:WG2는 H:0.8, B:0.8, 

423:WG3은 H:0.8, B:0.8, 511:RG1은 H:0.7, B:0.45, 215:G3A는 H:1.4, B:0.85 로

변경

22.  Section For Design 대화상자 버튼클릭

23.  Beam Design Result Dialog 대화상자 버튼클릭

24.           Unselect All 클릭

25.  Design Menu에서 Concrete Code Design > Beam Design 선택

N** : 부모멘트에대한

휨강도부족

*P* : 정모멘트에대한

휨강도부족

**V : 전단력에대한

강도부족

NP* : 부모멘트,정모멘트

에대한휨강도부족

*PV : 정모멘트,전단력

에대한강도부족

N*V : 부모멘트,전단력

에대한강도부족

NPV : 부모멘트,정모멘트

전단력에대한강도

부족


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그림 6.6의 버튼을클릭하면요약계산서가나타나고, 사용자가

선택한 Property별설계결과를단면의배근형상과함께확인할수있습니다. 

그림 6.6의 버튼을클릭하면사용자가선택한 Member별계산과

정및상세결과를 Text 형식으로확인할수있으며 fn.rcs File로저장할수있습니다.

그림 6.6의 버튼을클릭하면사용자가선택한 Member별

Property별설계결과요약을 Text 형식으로확인할수있으며 fn. rcs File로저장할수

있습니다.

6. 철근콘크리트부재설계

그림 6.6  Beam Design Result Dialog

  
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6. 철근콘크리트부재설계

Concrete Code Design기능을이용하여단면설계수행시적절하지않는부재가발생한

경우, 본 예제와 같이 Design Menu에 Concrete Design Parameter>Design Criteria Rebar

를선택하여철근정보를변경하거나 Design Menu에 Section for Design를선택하여해

당부재의단면치수를변경하여재설계를수행하여충분한강도를확보하도록설계합

니다.

Check Ratio가 1.0이내가 되면 설정된 설계조건(설계기준, 하중, 설계변수등)에 대하

여충분한강도를확보하였다고할수있겠습니다.

그림 6.7  Property ID 211의요약계산서출력


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6. 철근콘크리트부재설계

1.    모든부재의설계결과가 OK인것을확인후 Result View Option의 All 선택

2.                                    버튼클릭

3.                                버튼클릭

4.    설계결과요약 List 확인후 버튼클릭

5.                           클릭후저장

그림 6.8  재설계된 Property ID 211의요약계산서


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6. 철근콘크리트부재설계

그림 6.9  설계결과요약 List
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6. 철근콘크리트부재설계

1.    Sorted by Member 선택

2.    Member 36에 ‘’ 표시후 버튼클릭

3.    Special Seismic Load Combination이적용된것을확인후창닫기

그림 6.10  요소 6, 7, 8의상세계산서출력
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6. 철근콘크리트부재설계

6-3 보부재 강도검증

사용자가철근정보및단면크기를입력또는수정하여미리계산된부재력에따라강

도검증을수행합니다. 

1.    Main Menu에서 Design > Design > RC Design > Modify Beam Rebar Data

2.    Modify Beam Rebar Data의 “Property 211” 선택

3. ‘Same Main Rebar Size at Top and Bottom’ 에 ‘’표시

4.    ‘Same Main Rebar Size at I, M and J’ 에 ‘’표시해제

5.    그림 6.11 과같이 Rebar의단면정보를수정

6.    Detail Figure에서설정사항과동일한지확인

7. 버튼클릭

그림 6.11  Modify Beam Rebar Data



강도검증시에는 사용자가

입력한 철근정보에 대하

여 철근의 최소간격 등의

검토과정이 생략되므로

사용자가 철근정보를 입

력할 때 유의하여야 합니

다.



Modify Beam Section Data

기능은 강도검증시에만

사용되는기능입니다.


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6. 철근콘크리트부재설계

1. Modeling View Window에서선택된부재 “211 : WG1” 확인

2.    Main Menu의 Design > Design > RC Design > Concrete Code Check > 

Beam Checking 선택

3.    Beam Checking Result Dialog에 Property ID 211 강도검증결과확인

4.                                    버튼클릭

5.                                    버튼클릭

6.    그림 6.12에서Modify Beam Section Data에서수정된 Rebar 정보가반영된

것을확인

7.                             버튼클릭

8.    Beam Checking Result Dialog의 버튼클릭

9.             Unselect All 선택

그림 6.12  Modify Beam Rebar Data

Model Window상에서 선

택된 부재가 있으면 강도

검증시 해당부재에 대해

서만 단면설계 및 강도검

증을 수행하므로 유의해

야합니다.




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6. 철근콘크리트부재설계

6-4 기둥부재 설계

철근콘크리트 기둥부재 설계는 보부재 설계시 입력했던 설계변수가 동일하게 적용

됩니다.

1.    Main Menu에서 Design > Design > RC Design > Concrete Code Design > 

Column Design 선택

2.    Beam Checking Result Dialog 대화상자의 버튼클릭

3.    Result View Option 선택란에서 ‘NG’ 선택

4.    Connect Model View에 ‘’ 표시

5.                                  버튼클릭후 버튼클릭

6.    Main Menu에서 Design > Design > RC Design > Design Criteria for Rebars by 

Member 선택

7.    Column 탭클릭

8.    Main Rebar에 ‘D25’ 선택

9.    Ties/Spirals에 ‘D13’ 선택

10.  Arrangement의 Y에 ‘4’, Z에 ‘4’ 입력

11.                       버튼클릭

12. Main Menu에서 Design > Section > Section For Design 선택

13.  111:TC1 선택후 버튼클릭

14.  H: 1.6, B:1.2 입력후 버튼클릭

15. 같은방법으로 TC3 선택후 H: 1.2, B:1.2 입력

16. 버튼클릭

None : 주철근 이음을 고

려하지 않은 철근 개수 계

산

50% : 주철근 반수이음을

고려한철근개수계산

100% : 주철근 전이음을

고려한철근개수


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6. 철근콘크리트부재설계

그림 6.13  Column Design Result Dialog


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6. 철근콘크리트부재설계

1.    Main Menu에서 Design > Design > RC Design > Concrete Code Design > 

Column Design 선택

2.   적절한단면성능을가진것을 Result View Option의 ‘All’ 을선택하여확인

3.    Connect Model View에 ‘’표시

4.    Property ID ‘104, 105’선택

5. Modeling View Window에반영된것을확인 (그림 6.14 참조)

6.                                          버튼클릭

7.    Member No 선택란에서 ‘445’ 선택 (그림 6.15 참조)

8.    요소번호 445의 2방향소요모멘트를적용한 PM 상관도를마우스로드래그

하여 View Point를조정하여확인

9.    그림 6.17 의 버튼클릭

10.  요소축력및 2방향소요모멘트 Mny, Mnz를적용한 PM 상관도결과값출력

11.  모든대화창닫기

그림 6.14  Connect Model View

요소번호 319는 Property

ID 104중에축력과휨모멘

트비가 가장 큰 값을 나타

내는 요소를 나타낸 것입

니다.

요소번호 529도동일한경

우에해당합니다.


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그림 6.15  PM Curve Dialog

6. 철근콘크리트부재설계


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6. 철근콘크리트부재설계

그림 6.16  PM 상관도결과값출력

기둥부재의강도검증은보부재의강도검증절차와동일하며, 

Main Menu의 Design > Design > RC Design > Concrete Code Check > Column Checking

를선택하여수행합니다.
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6. 철근콘크리트부재설계

6-5 전단벽부재설계

일반적으로전단벽은다음과같은방법으로단면설계를수행합니다.

1.    전단벽체의부재력을산출하기위하여구조해석모델을작성하며, 전단벽벽은

실제의구조체와동일한모양을가지는 T-형, I-형, L-형등과같은형태로

입력합니다.

2.    현재의전단벽설계방법은일자형직사각형단면인경우에만단면설계가

가능하므로 T-형, I-형, L-형등과같은형태를몇개의일자형, 직사각형단면

전단벽부재로구분하여입력합니다.

3. 구조해석을수행하여일자형으로구분된각각의전단벽부재별로부재력을

산출합니다.

4.    산출된부재력을이용하여전단벽단면의배근방법(철근규격및배근간격)을

결정합니다.

전단벽의 설계 방법은 보강철근의 설계방법에 따라 다음과 같이 구분하여 사용자가

선택하여적용할수있습니다.

Method-1

벽체전길이에대하여등간격으로배근하는방법

(단부보강철근이없음)

Method-2

벽체 전길이에 대하여 등간격으로 배근되어 있다고 가정하고, 소요철근량을 산출한

다음단부및중앙부의철근을배근하는방법

Method-3

벽체 양단부에 배근한 철근이 축력(Pu)과 휨 모멘트(Mu)를 모두 부담하는 것으로

가정 하여 산출된 소요 수직철근량을 단부에 배치하고, 나머지 중앙부 구간은

전단력에의하여산출되는철근량으로배근하는방법

Method-4

설계방법2와동일하고, End Bar가 2EA부터배치되는방법

설계방법에 대한 자세한

설명은 On-line Manual참

조


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6. 철근콘크리트부재설계

본예제에서는 Method-3을적용하여전단벽설계를수행합니다.

1.            Unselect All 클릭

2.    Main Menu에서 Design >  Design >  RC Design > Design Criteria for Rebar 선택

3.    For Shear Wall Design의 Vertical Rebar 선택란우측의 버튼클릭

4.    ‘D10, D13’ 철근에 ‘’ 표시하고,                                     버튼클릭

5.    Horizontal Rebar 선택란의 ‘D10’ 확인

6.    End Rebar From 선택란의 ‘D13’ 선택

7.    그림 6.19 의 de 입력란에 ‘0.05’, dw 입력란에 ‘0.05’ 확인

8.                                                                                         버튼클릭

9.    End Rebar Design Method에서 ‘Method-3’ 선택

10.  Spacing of Vertical Rebar, Spacing of Horizontal Rebar를확인한후

버튼클릭

11.  Design Criteria of Rebar 대화상자의 버튼클릭

12.  ‘설계결과가삭제됩니다. 계속할까요?’메시지확인후,                         버튼클릭

13.  Main Menu에서 Design > Design > RC Design > Modify Concrete Material 선택

14.  Material List에서 6번Wall(1~4F)선택

15.  Rebar Selection의 Code에 ‘KS01(RC)’선택

16.  Grande of Main Rebar에 ‘SD400’선택

17.  Grande of Sub-Rebar에 ‘SD400’선택

18.  Concrete Materials Selection의 Code에 None선택

19.  Sepecified Compressive Strength에 ‘40000’입력

20.  Name 입력란에 Wall(1~4F)입력

21.                                 ,                               버튼클릭

de, dw 입력란에초기값을

‘0’으로 입력할 경우 프로

그램 내부에서 자동고려

하여 5.08cm(2.0 in)로 자

동설계하게됩니다.



보, 기둥부재의 경우 피복

두께의범위를 5.08cm (2.5

in) ≤ do ≤ 6.35cm (3 in)로

합니다.



수직철근의 배근간격은

사용자가 적용하고자 하

는 배근간격을 최대 5개

선택할수있습니다.


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그림 6.17 Design Criteria of Rebar

그림 6.18 Input Additional Wall Data

6. 철근콘크리트부재설계



그림 6.20 의 Design of

Out-of-plane Bending은 벽

체의 약축방향 휨에 대한

설계 여부를 선택하는

Option입니다.

해석모델에서 벽요소를

면외강성을 고려하는

Plate타입으로 해석한 경

우에는 체크해서 면외방

향 부재력에 대해서도 설

계를진행해야합니다.





122

midas Gen Tutorial KBC 2009를적용한철근콘크리트골조와전단벽을가진이중골조시스템

6. 철근콘크리트부재설계

벽체배근형태를동일하게적용할벽체요소들을조합하여 Wall Mark를부여합니다.

1.             Select Elements by Identifying 클릭

2.    Element Type 선택란에서 ‘WALL’ 선택후,                        버튼클릭

3.                                   버튼클릭

4.            Active,         Top View ,          Display 클릭

5.    Element탭클릭후 ‘Wall ID’에 ‘’ 표시

6.                                   버튼클릭

7.    Main Menu에서 Design > Design > RC Design > Modify Wall Mark Data 선택

8.    Wall Mark의 Name 입력란에 ‘W1’ 입력

9.    Wall ID List 입력란에 ‘1, 5, 8 ’ 입력

10.                       버튼클릭

11.  Wall Mark의 Name 입력란에 ‘W2’입력

12.  Wall ID List 입력란에 ‘2, 3, 4, 6, 7’ 입력

13.                       버튼클릭

14.  Wall Mark의 Name 입력란에 ‘W3’입력

15.  Wall ID List 입력란에 ’9,10,11’ 입력

16.                       버튼클릭

Wall Mark를 수정하고자 하는 경우에는 부여된 Wall Name을 선택하고, Operation의

Modify탭을이용하여 Wall Mark Data를수정할수도있습니다.

그림 6.19 Wall Mark 데이터입력

Wall ID 입력시 Wall ID

List 입력란을마우스로한

번클릭하여마우스 Editor

를활성화후, 입력할 Wall

ID를 화면상에서 마우스

로 클릭하여 입력할 수도

있습니다.


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6. 철근콘크리트부재설계

6-6 전단벽부재설계결과확인

1.    Main Menu에서 Design > Design > RC Design > Concrete Code Design > 

Wall Design 선택

2.    Wall Design Result Dialog에서 Wall ID별설계결과확인

3.                                    버튼클릭

4.                                    버튼클릭

5.    그림 6.21 의단면번호선택란에서원하는단면번호를선택하여벽체설계

결과및배근형태확인

6.                             버튼클릭

그림 6.20 Wall Design Result Dialog

 
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1.    그림 6.20 의 ‘Wall ID + Story’ 선택

2.    Wall ID 1번의 1층벽체를선택하고,                                 버튼클릭

3.    상세계산서를통해벽체설계과정및결과확인

4.    닫기(        ) 버튼클릭

5.    상세계산서파일저장

6.                                           버튼클릭

7.    PM curve Dialog에서 PM 상관도확인

8.                                   버튼클릭

그림 6.21 벽체설계결과및배근형태 (요약계산서)

6. 철근콘크리트부재설계


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6. 철근콘크리트부재설계

그림 6.22 벽체설계의상세계산서
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6. 철근콘크리트부재설계

그림 6.23 PM Curve Dialog

그림 6.22 의 버튼을클릭하면벽체설계결과를 Wall ID별또는

Wall Mark 별로분류하여 fn.rcs File로저장하여출력할수있습니다.
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6. 철근콘크리트부재설계

6-7 Wall Mark별설계결과출력

1.    Wall Design Result Dialog의 버튼클릭

2.    Sorted by 선택란에 ‘Wall Mark’ 확인 (그림 6.26 참조)

3.    List for Selecting선택란에서 ‘W1, W2’선택

4.         버튼클릭

5.    Sorting Story Options선택란에서 ‘Descend’확인

6. 버튼클릭

7.                                                               버튼클릭

8.    Wall Mark별설계결과확인

9.    닫기(       ) 버튼클릭

10.  경로를지정하여Wall Mark 별설계결과를 ‘fn.rcs’ 형태로저장

그림 6.24 Wall Result Sorting Dialog





여러 개의 Wall Mark를 선

택할시에는키보드의 Ctrl

키를 누른 후 마우스로 원

하는 Wall Mark를 선택합

니다.



Sorting Story Options의

‘Ascend, Descend’ 는층정

렬방식을나타냅니다.



그림 6.23에서 사용자

가 출력을 원하는 층을

선택할 수 있습니다.


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6. 철근콘크리트부재설계

그림 6.25 Wall Mark별설계결과
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6-8 Wall ID별설계결과출력

6. 철근콘크리트부재설계

1.    그림 6.24 의 ‘Wall ID’ 선택

2.    List for Selecting선택란에서 ‘1, 2, 3, 4, 5, 6’ 선택

3.      버튼클릭

4.    List for Printing선택란에서 ‘W1, W2’ 선택후 버튼클릭

5.                                                              버튼클릭

6. Wall ID별설계결과확인

7.    그림 6.26 의닫기버튼(       ) 클릭후,                        버튼클릭

8.    Wall Result Sorting Dialog의 버튼클릭



그림 6.26 Wall ID별설계결과

설계결과는 filename.rcs로

저장됩니다.


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6-9 전단벽부재강도검증

6. 철근콘크리트부재설계

1.    Main Menu에서 Design > Design > RC Design > Modify Wall Rebar Data 클릭

2.    Modify Wall Rebar Data의 Wall ID 1, Story 1F이선택된것을확인

3.    그림 6.27 과같이 Rebar의단면정보를수정

4.                                          버튼클릭

5. Design Menu의 Concrete Code Check > Wall Checking 선택

6.                                    ,                                   버튼클릭

7.    그림 6.28 의변경된 Rebar 정보및강도검증결과확인

8. 버튼클릭

9.    Wall Checking Result Dialog의 버튼클릭

그림 6.27 Modify Wall Rebar Section


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6. 철근콘크리트부재설계

그림 6.28 강도검증요약계산서


